Canon  Windows |

Image Viewing, Organizing and Editing Software

ZoomBrowser EX
Ver. 6.7
Instruction Manual

In this manual, ZB is used for ZoomBrowser EX.

In this manual, the screens used in the basic operation instructions are
from Windows 7, with some portions using screens from other versions

of Windows.

Click on the icons below on the bottom right of the screen to switch
between pages.

@ . Go to next page @ . Go to previous page
. Return to a page you had previously displayed

Click on the chapter headings on the right side of the screen to switch to
the contents page of each chapter.
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READ CAREFULLY BEFORE USING!

CANON SOFTWARE LICENSE AGREEMENT

IMPORTANT - READ THIS AGREEMENT BEFORE USING THE SOFTWARE ON THE CD-ROM
IN THIS BOX. BY USING THE SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF
THIS AGREEMENT.

This is a license agreement (the [Agreement]) between you and Canon Inc. ([Canon]).

IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE PROGRAM ON THE CD-ROM AND THE USER MANUAL IN THIS BOX
(COLLECTIVELY, THE [SOFTWARE]) AND RETURN THE SOFTWARE WITHIN 30 DAYS FROM
THE DATE OF PURCHASE TO YOUR POINT OF PURCHASE FOR A REFUND.

In consideration of the right to use the SOFTWARE, you agree to abide by the terms and conditions
of this Agreement.

1. LICENSE: Canon grants you the non-exclusive right to use the SOFTWARE only on a single
computer. You may physically transfer the SOFTWARE from one computer to another provided
that the SOFTWARE is used on only one computer at a time. You shall not install or use the
SOFTWARE on a network, multiple CPU, multiple site arrangement, or any other hardware
configuration where the SOFTWARE is accessible to more than one CPU or to more than one
user.

YOU SHALL NOT ASSIGN, SUBLICENSE, RENT, LEASE, LOAN, CONVEY OR OTHERWISE USE,
TRANSFER, COPY, TRANSLATE, CONVERT TO ANOTHER PROGRAMMING LANGUAGE,
ALTER, MODIFY, DECOMPILE OR DISASSEMBLE THE SOFTWARE, IN WHOLE OR IN PART,
EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. BACK-UP COPY: You may make one copy of the SOFTWARE solely for back-up purposes, or
copy the SOFTWARE onto the permanent storage device (e.g. a hard disk) of your computer
and retain the original for back-up purposes. Any other copying of the SOFTWARE is a violation
of this Agreement. You must reproduce and include the copyright notice on the back-up copy.

3. SUPPORT AND UPDATES: Canon is not responsible for providing maintenance or support for
use of the SOFTWARE. No updates, fixes or support will be made available for the
SOFTWARE.

4. LIMITED WARRANTY AND LIMITATION OF LIABILITY: It is your responsibility to choose,
maintain and match the hardware and software components of your computer system. Thus
Canon does not guarantee uninterrupted service or correction of errors or that the functions or
performance of the SOFTWARE will meet your requirements. THE SOFTWARE IS LICENSED
ON AN [AS IS] BASIS AND WITHOUT WARRANTY OF ANY KIND. The CD-ROM storing the
SOFTWARE is warranted only against defective material under normal use for a period of ninety
(90) days after purchase from an authorized Canon dealer as evidenced by your sales receipt.
Your sole remedy for a defective CD-ROM shall be replacement of the same without charge
when returned by you at your expense to your point of purchase and proven to be defective
upon inspection. The replacement CD-ROM will be warranted for the remainder of the original
ninety (90) day warranty period of the defective CD-ROM. The limited warranty does not apply if
the failure of the CD-ROM resulted from accident, abuse or misapplication of the SOFTWARE
and shall not extend to anyone other than the original user of the SOFTWARE.

EXCEPT AS SPECIFICALLY SET FORTH IN THIS PARAGRAPH 4, CANON, CANON'’S
SUBSIDIARIES, DISTRIBUTORS AND DEALERS DISCLAIM ALL WARRANTIES, EXPRESS OR
IMPLIED, INCLUDING ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE.

NEITHER CANON NOR ANY OF CANON'S SUBSIDIARIES, DISTRIBUTORS OR DEALERS IS
LIABLE FOR ANY DAMAGES HOWSOEVER CAUSED, INCLUDING WITHOUT LIMITATION,
DIRECT, CONSEQUENTIAL OR INCIDENTAL LOSS OR DAMAGE INCLUDING LOSS OF
PROFITS, EXPENSE OR INCONVENIENCE HOWSOEVER CAUSED OR ARISING OUT OF THE
SOFTWARE OR THE USE THEREOF.

NEITHER CANON, NOR ANY OF CANON'’S SUBSIDIARIES, DISTRIBUTORS OR DEALERS
SHALL HAVE ANY OBLIGATION TO INDEMNIFY YOU AGAINST ANY CLAIM OR SUIT
BROUGHT BY A THIRD PARTY ALLEGING THAT THE SOFTWARE OR THE USE THEREOF
INFRINGES ANY INTELLECTUAL PROPERTY OF SUCH THIRD PARTY.

5. TERM: This Agreement is effective upon your using the SOFTWARE and remains in effect until
expiration of all copyright interests in the SOFTWARE unless earlier terminated. You may
terminate this Agreement by destroying the SOFTWARE. This Agreement will also terminate
without notice to you if you fail to comply with any of the terms of this Agreement and you must
then promptly return the SOFTWARE. In addition, Canon may enforce its other legal rights.

6. U.S. GOVERNMENT RESTRICTED RIGHTS NOTICE: The SOFTWARE is provided with
restricted rights. Use, duplication or disclosure is subject to restrictions as set forth in either
subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer software clause at
DFARs 252.227-7013 or subparagraph (c) (1) and (2) of the Commercial Computer Software
Restricted Rights Clause at FAR 52.227-19, as applicable.

7. SEVERABILITY: In the event that any provision of this Agreement is declared or found to be
illegal by any court or tribunal of competent jurisdiction, such provision shall be null and void
with respect to the jurisdiction of that court or tribunal and all the remaining provisions of this
Agreement shall remain in full force and effect.

8. CONTROLLING LAW: The terms of this Agreement as it relates to purchases of the Software in
the United States of America shall be governed and construed in all respects in accordance with
the laws and regulations of the State of New York, without reference to choice of law principles.
The terms of this Agreement as it relates to purchases of the Software in Canada shall be
governed by the laws of the province of Ontario.

9. OWNERSHIP: All rights, including but not limited to copyrights and trade secret rights, to the
SOFTWARE belong to Canon, its affiliated corporations and third party licensors. Your use of
the SOFTWARE is subject to the United States, Canada and other applicable copyright and
trademark laws and nothing in this Agreement constitutes a waiver of the rights of Canon, its
affiliated corporations and third party licensors under such laws.

Nothing contained in Paragraph 1 shall be construed to give Canon any ownership rights in any
images, graphics or textual material that you save in connection with the Software.

10.ACKNOWLEDGEMENT: BY USING THE SOFTWARE, YOU ACKNOWLEDGE THAT YOU
HAVE READ THIS AGREEMENT, UNDERSTOOD IT, AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS. YOU ALSO AGREE THAT THIS AGREEMENT IS THE
COMPLETE AND EXCLUSIVE STATEMENT OF AGREEMENT BETWEEN YOU AND CANON
CONCERNING THE SUBJECT MATTER HEREOF AND SUPERSEDES ALL PROPOSALS
OR PRIOR AGREEMENTS, VERBAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS
BETWEEN THE PARTIES RELATING TO THE SUBJECT MATTER HEREOF. NO
AMENDMENT TO THIS AGREEMENT SHALL BE EFFECTIVE UNLESS SIGNED BY A DULY
AUTHORIZED OFFICER OF CANON.
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Introduction

Main Features of ZB

Download images to your computer
Check images
Print images
Organize images
Edit images
Adjust images
Trim images

Insert text
Correct red-eye

Utilize images
Attach an image to an e-mail
Create wallpaper or a screen saver

Convert images
Change image size and type

Play Movies
Use your images with CANON iMAGE GATEWAY
Sym bols Used

: Selection procedure for menus that appear on the computer
screen
[ ] :Names of items and menus, buttons, windows, etc. that appear on
the computer screen
: Camera switch name or icon, or a keyboard key name
: Reference page (jump to page by clicking)

I

<>
p.**
"2 :Help @< Tip

: Important information |§| : Helpful information

Makeup of Each Chapter

Chapter 1 Basic Operation
Starting up and exiting ZB
Downloading images to your computer
Checking images
Playing movies
Printing images

Chapter 2 Advanced Operation

Efficient checking of images
Organizing images

» Editing images

@® Editing movies
Utilizing images

@ Index printing

Chapter 3 High-Level Functions
© Checking images with high-level functions
Organizing images with high-level functions
Advanced image editing
Printing with other software

Chapter 4 Preferences
Settings for all functions

Chapter 5 Using Images on the Internet
Using your images with CANON iIMAGE GATEWAY

Reference
Solving problems

Uninstalling ZB

System requirements

Supported images

Lists of primary window functions
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Starting up ZB

Double-click the desktop icon.

Double-click

ZB starts up and the main window appears.

v

Ii
LS
i

Downloading an Image to Your Computer

Connect the camera and computer with the cable provided and

download the images saved on the memory card inserted in the camera.
For downloading images, start up the camera software “EOS Utility”

from ZB and use.

Select the save destination for the images.

Lazt Acquired Images @

Images acquired from your
camera can be accessed here.

| Favaorite Foldelu All Folders E

=l Desktop

- 3 CANON

..... iz Contacts

...... 4. Downloads

@1 Favorites

..... P Links

AN =) My Documents
..... My Music

»

m

=t & My Pictures
----- B My Videos
----- i# Saved Games
B 5 Searches
-}y Public

-8 Computer

€ | 1] | 3

Add to Favorites

Click to display the [All
Folders] tab sheet

Click

When creating a folder, refer to p.27.
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Start up EOS Utility.
Click the buttons [Acquire & Camera Settings] » [Connect to
EOS Camera].

‘ i) | Acquire & Camera Settings

Acquire Imaages from Memory Card

” Connect to EOS Camera

Tranzfer Images to Mermary Card

EOS Utility starts up.

v

EOS Utility
EI EOS Utility

Control Camera Accessories

Monitor Folder
iy

Connect your camera and computer and turn the

camera on.

Connect the camera and your computer with the interface cable
provided with the camera and turn the camera on.

For detailed instructions on connecting your camera and
computer, refer to the “EOS Ultility Instruction Manual” (PDF

electronic manual).

When the dialog box below appears, select [Canon EOS Utility]

and then click the [OK] button.

Canon EOS XXX

Camera connected

Select the program to launch for this action;
'j\‘-.‘.. Canon Camersyyindow
™ Downloads Images From Canon Camera

Canon EOS Litility
Downloads images from EOS camera

] ticrozoft Scanner and Camera wWizard
Download pictures from a camera of scanner

[] &hways uze this program for this action

I (]S l [ Cancel
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Introduction

Download images. Downloading Images Using Your Card Reader
I, EOS Utility - EOS XXX et | . . . Table of
— You can also download images to the computer using a third-party card Contents

Select the save destination for the images (p.7).

Starts to download images Click
Lets you select and download images Load the memory card into the card reader.
Advanced
Camera settings/Remote shooting Operatlon
Monitor Folder .
High-Level
Functions
[ Quit |
] ] ] Preferences
Downloading of images begins. O e o e hox bel lick Ivi
The downloaded images are saved in the folder selected in step _ enCt N '3 9 BOX € O\I/vaappza;sé Ct'C t[Vlew/DownIoad Images
1 and are displayed in the main window of ZB. ~ L[j)s'ng Z.non oom roc\)NSser | ] anv. /; ar SIUD('j | _ Using the
The downloaded images are sorted into folders by date and epending on your OS, select [View/Download Images using Internet

saved Canon ZoomBrowser EX] and then click the [OK] button. ZB

Click the EOS Utility [Quit] button to exit EOS Utility and turn the _ starts up. _
camera’s power switch to < OFF >, = AutoPlay aln e Reference

EOS_DIGITAL (G3)

-—
[] Always do this for pictures: Contents
Lookup
Pictures options
i Import pictures and videos
@ View Download Images Index

General options -

Open folder to view files

| : Explorer
P Speed up my system
=" using Windows ReadyBoost

: ReadyBol

E\@/E Advantages of using EOS Utility to download images b - i @
9

View maore AutoPlay options in Control Panel

Using EOS Utility to download images makes it easier to organize your L
images as they are downloaded, sorted and saved into folders by date. Proceed to step 4.



Start up ZB.

Click the buttons [Acquire & Camera Settings] P [Acquire

Images from Memory Card].

‘ i) | Acquire & Camera Settings

Connect to EOS Camera

Acquire Imaages from Memory Card

Tranzfer Images to Mermary Card

Download images window appears.

Download images.
Download images window

ZoomBrowser EX

'-ae

Canon

[ Download Images w

Lets you select and
download images

[ Print Menu w

Preferences... Exit

— . Y

Downloading of images begins.

~» The downloaded images are saved in the folder selected in step
1 and are displayed in the main window of ZB.

» The downloaded images are sorted into folders by date and

saved.

Click

© Click the [Exit] button to exit Download images window.

-I@/E Advantages of using ZB to download images

Using ZB to download images makes it easier to organize your images
as they are downloaded, sorted and saved into folders by date.

® Depending on the card reader and computer OS used, SDXC cards
might not be correctly detected. In such a case, connect your
camera and computer with the provided interface cable, and
transfer the images to your computer.
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Viewing an Image

Images and movies downloaded to your computer are displayed as a
thumbnails list in the main window. You can double-click a thumbnail to
open the viewer window and display an image at a larger size or play a
movie.

View Images as Thumbnails in the Main Window

Click to select the image

O | Sl vewbrw & | Propefies ;-' Side Show | b Semch (] Delere Ly roune
Zaers Mads | Scrol Mo | Prerfe Mods|

fl:l Viers & Clsssy My Pihires =g 2

ol o 1 oo 02

= =g S

| Fpom

el Pt Shae - - I

- [

': CANDN MAGE GATEWAT o X

- i 5
e P e

Laut Acgaied Imsges [ ]

Celectad Rem:

Display thumbnails of all the
images inside the folder selected
in the folder area on the left

To select multiple images, click on the images while holding
down the < Ctrl > key on the keyboard.

-I@/E Simple Display Function

Move the cursor over the image with the
mouse and you can check images that
are displayed in the simple display
window (mouse over window).

To deactivate simple display, click on
[ﬂ] on the top of the window, select
[Show Mouse Over Windows] from the
menu and remove the check mark.

Simple display window

|§| For a list of the main window functions, refer to p.88.
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Enlarging a Selected Folder

Images downloaded to your computer are displayed in folders in the
main window. Double-click on an empty part of the folder you want to
enlarge to zoom in and display the images inside that folder at a larger

size.

Enlarge folders.

Bt Tos eme el

Q| ] Viewbrge -] ropenies _:]uq.w.. [ Seah 1] Dee Dy arme

o e b ToiesMcn | Sk oda | PreviwMods)

!V.Z'E..““‘“"’ My prenes Q00 E-6-E I

[=fen

e o 0T oo

| B oy W = "

e - = L =4 o L

S — T B ity et F

Lk Acgared Insgss [«] P =1 o v - e
—mmpe  mEET

The folder you have double-clicked zooms in.

v

— Double-

click on an
empty part
of the folder

Ble 62 Yoew ook jninnet  Help

ol . dl® S
| ] Aty & Camas fatiege ZocesM2ds | Sciol Wad | Preview Mods|

G U0 H-0-Ea

=

Raut Acquied Images (2] IMG_0001JPG  IMG_OO0ZIPG  IMG_O0OIIPG  IMG_0004.9G

| | [ Fam

|0 vy | =
I‘,{ £x
=

|3 Pt Shes

|7, cnion aat oaTEwY

IMG_0005.1PG  IMG_0006.1PG  IMG_DOOZ.JPG  IMG_D00H. G

IMG_0009.0PG  IMG_O010.JPG  IMG_OMLIPG IMG_OM2LNG

IMG_O013.0PG  IMG_O014.IPG  IMG_ODIS.IPG  IMG_OMME.NG

£ My Pictures
I
|| b

= 0

Celectad Rem:

® To revert to the folder size before enlarging, click [ ﬂ ] on the top
of the window.

|§| You can change the speed at which a folder zooms in (p.77).
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Changing the Display Magnification

If you have many images inside a folder and they are small and difficult
to see, you can change the display magnification and display the
images at a larger size.

Change the display magnification.
Drag to the right

£h F.ﬂ Delete @1 Rotate
R0 |R-0- [0 | [m.::ge L5 Fiter -

You can also change the display magnification by clicking [ ‘% ]
or[ =]
The display magnification of the images changes.

' Navigator window

Enlargement
display position
Drag to move the
enlargement
display position

The [Navigator] window appears and you can check and move
the enlargement display position.

You can also move the enlargement display position by clicking
[ ] on the top of the window and dragging over the window.
To return to full view, click [ .. ] on the top of the window.

Enlarging and Viewing Images One at a Time

Double-click an image to enlarge.
Double-click

Colectad Ber: 0

=» The viewer window appears.
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Click [€2 ] or [ €2 ] to switch to the image you want to
display.

Viewer window

B o || Ler-| @B show [J)2 M M0 @ |
ol R[] | ¢ e ¢ ur e | MG0001IPG @ /16)

Zoom Ratio: 2%

The shooting information is displayed by clicking [ =& ] on the
top of the window.

To exit the viewer window, click [ [l ] on the top right of the
window.

? When you display RAW images in the viewer window

In the viewer window, the JPEG embedded in the RAW image is
displayed instead of the actual RAW image. In some cases, displayed
images may be grainy.

To check the actual RAW image, use the bundled software Digital Photo
Professional.

@ For a list of viewer window functions, refer to p.91.

Displaying an Image Across the Whole Window (Full View Display)

Double-click on the image you want to display
across the whole window.

—— Double-click

® You can also display the image across the whole window by
clicking [ [=7]] on the top of the window.

=» The image is enlarged and displayed across the whole window.

To return to the viewer window, click on the window or press the

< Esc > key on the keyboard.
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Playing Movies

You can play movies and Video Snapshot Albums that you have shot.
Movie files are marked with the [ [] ] icon and Video Snapshot Albums
with the [EZ}] icon in the thumbnail image frame in the main window.

In the main window, double-click a movie (image

marked with the [ [ ] icon) or a Video Snapshot

Album (image marked with the [Eh] icon).
Double-click

T

A viewer window appears and the movie starts playing.

& w ]2 [ [ B

M Save s snll image 6 Cut Move | IMGO0L0MOY (10115

© Playback stops automatically when the movie ends.
©® To play the same movie again, click the [ B ] button.
> You can save the currently displayed scene as a still image by
clicking the [Save as still image] button.
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Rewriting Images to a Memory Card

You can rewrite images and MOV movies that you have saved on a
computer to a memory card and then play them back on the camera.
Use a third-party card reader to rewrite your images or movies to a
memory card.

Insert a memory card that has been formatted on the
camera into the card reader.

Select the image or movie you want to rewrite.

e mgml  =psas

s LY S [ g e 10
—mEs  =ARET
£ e o] 2 | e

b 2..-:';"": p ‘I ]
sEE) ZRiAD

Rewrite the image or movie.
Click the buttons [Acquire & Camera Setting] » [Transfer Images
to Memory Card].

‘ 1| Acquire & Camera Settings ‘

‘ Connect to EOS Camera

Acquire Imaages from Memory Card

Tranzfer Images to Mermary Card

Select the destination memory card and click the
[OK] button.

Please select a memory card.

A confirmation window appears.

Click the [Transfer] button in the confirmation
window.
¥ Image or movie exporting begins.

@ You cannot rewrite MOV movies that have undergone movie
editing (p.40) or movie exporting (p.61) to a memory card.
AVI movies cannot be rewritten to a memory card.
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Printing an Image

This section explains how to print one image on one sheet of paper, and
how to print using Easy-PhotoPrint EX.

Printing One Image on One Sheet of Paper

You can print one image on one sheet of paper.

Select the image to be printed.

T
SRS

To select multiple images, click on the images while holding
down the < Ctrl > key on the keyboard.

You can select all the images inside a folder by clicking on an
empty part of the folder.

Display the print settings window.
Click the buttons [Print & Share] P [Photo Print].

Index Print

The [Photo Print] window appears.

Set the paper size and other settings, and then click
the [Print] button.

Add ar Modify textto print with

0 Settings o
Remove unwanted regions | thie photo
-I:I of your photo, -T

TrimImage Insen Text

= T

T BlZ =
2 2|2 ;e
2 |55 (DII5 |3

g3 =
2lg\g B
a8 &

E 8

“ 4

E
@
7

“

Total: 1 pages

Printing begins.

@ When printing RAW images, the JPEG embedded in the RAW

image is printed instead of the actual RAW image. In some cases,
printed images may be grainy.

|§| For a list of photo print window functions, refer to p.94.
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Printing an Image Using Easy-PhotoPrint EX

If you have an inkjet printer that is compatible with the Easy-PhotoPrint
EX (hereinafter, “EPP EX") software for Canon printers, you can start up
EPP EX from within ZB and easily perform high-quality photo printing.

To perform this printing, it is necessary to first install EPP EX version 1.0

or later on your computer.

Also, Easy-PhotoPrint users can select [Easy-PhotoPrint] in step 2 and

print following the same steps.

Select the image to be printed.

Click
m‘::is O | St B roticr Bl stesen [R50 (5 00me
| 8] Acqume t Camuin tatirge ersMoon | S M | Preimnde
[ Pehre: Q0o ®H-0-E I
L e —
o, | BallE | EgeEs
—Emge  =mEEET
e DELs
e
e EEELS
Sess - | 28ii=
s a-sez- | T Rubaie
Nl b g

To select multiple images, click on the images while holding

down the < Ctrl > key on the keyboard.

You can select all the images inside a folder by clicking on an

empty part of the folder.

Start up EPP EX.
Click the buttons [Print & Share] » [Easy-PhotoPrint EX Photo

Print].

e

‘ s 1 Print & Share

‘ Fhata Print

Ides Print

E azy-PhotoFrint Ex
Fhata Print

| Create and Print Album

EPP EX starts up.

Specify the number of copies to be printed and then
click [Select Paper].
Easy PhotoPrlnt EX

@ Select Images

==
—_—
| @ Layout/Print |

—

Speafy the number of copees to pont fior each imege.
o cameckor evhumer mages, rs-ienvrmm,ﬁhuwhmm

ey Exif Print

e o W B SetbyDee & ~

1MG_0002 S0 _peoe I mr w
=] 3 ]{=] |> | 1 |-| =M 1 [{=] 'JH

‘ -l-“’ i '

a3_8013.PD IME_pot4JPa

=i ll=) =il =)

(|

Selectons 16 mage(s)

TI1 IEECT L S

IU(: _DU0Z.. ING_D003... IMG_U004... IMG_D005. IM(;_{.IU[HJ IG_D007_ IMG_U008... IMG_U00E... ING_DU10... IMG_D0T1... ING_D0T2.. (MG_0013.
'

Click to increase the number of copies to be printed
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Introduction

Specify the paper size and then click [Layout/Print]. SpeC|fy the Iayout and then C|ICk the [Print] button. N
:I foin_iew tip —— I :dn tin I Table of
~ St the prter to use, Then select the soe and type of paper for omtng. ~ Select the layout you want 1o prnt. Contents
icerdives Exif Print Ehots ey Mg o et Exif Print
| e = S RSP T — [ |82t aes
[® .mm:nm- | K::imm Homs [® -'anlnr:mo- | I:I n .‘
* P — el e seiees
|r;l, Selact Paper |® Srhert Pager | |
N ] [] o D j D = QQ M;II___I
(9 unoutioen | : [0 oo | @i teed
m??; ;5:::;,, \-'I?;‘:';:'.‘l‘ Credit Card Phote Paper Pro. MDOPW‘H.S fakeasy Phote Faper | Advan Ced
. — Operation
L] (o) L]
) o High-Level
_‘ Functions
|DJ |L_1J Preferences
L
[ em | ) P
= Printing begins. Using the
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|§| You can also create an album with EPP EX by clicking the [Create @
and Print Album] button in the menu in step 2. 19



Exiting ZB

In the main window, select the [File] menu P [Exit].

Opendtion

( )

=» ZB exits.

O || il £
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Checking/Sorting Images introduction

You can enlarge images one at a time from a list in the main window, Click [€2 ] or [ €2 ] to switch to the image you want to
check what they look like in detail, and sort them with ratings. display. ble of
Viewer window Contents

Enlarging and Checking Images One at a Time

. . . A0 [ affen| wer ()5 T @ E | Basic
Double-click on the image on the top left of the main R [ B | 0 v Ut v oy | MOOOLRGR/ Operation
window.

Double-click
Advaficed
Op ion
High-Level
1;:“_ w@- g Functions
o, | HalE | RgeEs |
e mBARET
P e | T T Preferences
Erofms-  EETas
TR - | 2iidie= Using the
RN L S ke S Internet
G A= gy ~
. e The shooting information is displayed by clicking [ =& ] on the
The viewer window appears. To exit the viewer window, click [ [l ] on the top right of the
window.
When a RAW image is Qisplay_ed ip the vievyer window, the JPEG EaTEn S
embedded in the RAW image is displayed instead of the actual Lookup
RAW image. In some cases, displayed images may be grainy. To
check the actual RAW image, use the bundled software Digital
Photo Professional. Index

=@)= To display only selected images in the viewer window

Select multiple images in the main window (p.11) and then click on @ @

[ [@a] viewImage] ] on the top left of the main window (p.88) to display only

the selected images in the viewer window. @
22

|§| For a list of viewer window functions, refer to p.91.



Enlarging a Specific Part of an Image
Enlarge an image.

| & ZoomBrowser EX - E\Use

File Edit View Help
QO RADIE| L] - B

= (@] @__,, [V¢ v vr wr ¢ | IMG000L)

Drag to the right

You can also change the display magnification by clicking [ ‘%, ]
or[=L1].

The image enlarges and the [Navigator] window appears.

RAW images cannot be enlarged.

Display the part of the image you want to check.
Drag the enlargement display position in the [Navigator] window
and display the part of the image you want to check.
Navigator window

Mavigator

-

Enlargement
display position
Drag to move the
enlargement
display position

_ Enlargement ratio
You can also move the enlargement display position by clicking

Zeom Rate:56%)

[+ 7] on the top left of the window and dragging over the window.

To return to full view, click [ .= ] on the top left of the window.

Sorting Images

You can sort images into one of seven groups by setting ratings
according to the photo subject or a theme.
Ratings can be set from the following seven types.

¢ (none), [e], [vevel [ LI 11 1, [Reject]

Increase or decrease [¢].

| [l ZoomBrowser X - E\Users

File Edit !_iew Help - L
0 aqdls
R (e 5 (v

Click to decrease

oot — Click to increase

[Reject] cannot be set in the viewer window. Set [Reject] in the
main window.

@ ® You can display and change rating settings set in ZB version 6.6
or later with other bundled software or on an EOS 60D, EOS
REBEL T3i/600D, or EOS REBEL T3/1100D camera.

« EOS Utility version 2.9 or later:
Ratings set in ZB version 6.6 or later are displayed on image
thumbnails in the viewer window. However, [Reject] is not
displayed and you cannot change rating settings.
« Digital Photo Professional version 3.9 or later:
Ratings set for still images in ZB version 6.6 or later are
displayed on image thumbnails in the main window, etc. You
can also change rating settings.
* On an EOS 60D, EOS REBEL T3i/600D, or EOS REBEL T3/
1100D camera:
Ratings set in ZB version 6.6 or later are displayed in the
playback screen. You can also change rating settings. However,
you cannot display or change settings for [Reject].
Reversely, you can also display and change with ZB version 6.6
or later the rating settings set for still images in Digital Photo
Professional version 3.9 or later or on an EOS 60D, EOS REBEL
T3i/600D, or EOS REBEL T3/1100D camera.
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Sorting Images in the Main Window

Select images in the main window, and then select
the [Edit] menu P> [Change Rating] P> select the

setting.
Edit
Copy Ctrl+C
Paste Ctrl+V

Copy to Folder...

Move to Folder...

Select All Ctrl+A
Select Bracketed

Clear Selection Ctrl+R
Rotate...

Rotate According to Rotation Information

Change Rating £0

1

Add/Remove Sound... 5

Play Sound... 5

4

EditImage... 5
| Reject

You can also right-click with the mouse on a thumbnail image in
the main window, and then from the menu that appears select
[Change Rating] P> select the setting.

Arranging Images in the Main Window

You can arrange images in order of the ratings attached to them, or

according to the image’s shooting date and time.

Select the [View] menu P> [Sort by] P> desired item.

View

Zoom Mode
Scroll Mode

Preview Mode

View Image...

View as a Slide Show...
Go Back

Go Forward

Zoom In'to Falder

Zoom Cut of Folder

Task Area

Last Acquired Images Area

Task and Folder Areas
Show Information

Sort by
Filter

Add New Favorite Folder...

Refresh Current Folder

Properties...

Ctrl+ G

Ctri+B

F5

The images are arranged in the order according to the selected item.

Name

Shooting Date
Modification Date
Rating

Type

Ascending

Descending
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Sort item Description
Rating [Reject], -r (none), Images are arranged in the order of the
least number of [ < ¢ ].
Name Image file names are arranged in the order of 0 -9 - a — z.

Shooting Date Images are arranged in the order of maost recently shot.

Modification Date Images are arranged in the order of most recently updated.

Type Images are arranged in the order of BMP images —
RAW images - JPEG images > MOV movies = TIFF
images.

Ascending Images are arranged from top to bottom in order of sorting criteria.
Descending Images are arranged from bottom to top in order of sorting criteria.

Filtering Images You Want to Display

You can filter images displayed in the main window by the ratings you
have attached to them.

Click the [ ] button.

Eh ‘Cﬁ Delete :_:‘ﬂ! Rotate

__J @|Eﬁ'ﬁ‘|*‘ | D—-—-’—"‘ §i Filter -

The filter function appears.

Set the criteria to filter images.

— —= — B o
il | View Image g‘:ij Properties ml Slide Show I ¥ Search ‘.:j Delete _,:&\ Rotate

_mi Scroll Mode | Preview Modei
My Pictures (2] | EQ ~0 - | E
[ Filter by Rating: ( Al » | Greater than )

Only the images with the criteria you have set are displayed in
the main window.
To exit the filter display, click the [ ] button again.

® To users of ZoomBrowser EX ver. 6.5 and earlier
The method for setting ratings has greatly changed starting with ver.
6.6.
Accordingly, a rating may be displayed differently even for the same
image between ver. 6.6 or later and ver. 6.5 and earlier.
For detailed information, refer to the Help for ZoomBrowser EX ver.
6.6 or later.
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Efficiently Checking/Sorting Images introduction
With the Preview Mode that displays images as thumbnails and single Click the | ] orthe[ ] button

images in the same window, you can efficiently check the images. You to switch to the image you want to check, and then Table of
can also check the images’ shooting information or sort them by setting . h ’ Contents
sort by setting a rating.

their ratings.
The selected image is enlarged in
the center of the window

Click to increase or decrease

Enable Preview Mode. Basic
RS Operation
T‘k‘ i D | Gl viewimage al siceshow [ seorcn 77 petete 5y rotate
2] Viewlmage Z’; roperties ;?J Stide Show | . Search T Delete @Rotate I} vy ZM“‘iHM o Q0 ; \:?’al\ & e 3 Ad od
Zoom Mods |55,0||M0d@ @ i Zf i‘ S I Op% on
My Pictures Q 0| =R-0 - |[k] ErTr— ’ ;
3 oo wase catewar
_ o High-Level
Click Functions
The main window display switches to Preview Mode.
Double-click the folder with the images you want to
= - - Preferences
Using the
Internet
L Reference
Thumbnail image display area
You can also click on the image in the thumbnail image display
area to display the image enlarged in the center of the window. Contents
When a RAW image is displayed, the JPEG embedded in the RAW Lookup
image is displayed instead of the actual RAW image. In some cases,
A5 A displayed images may be grainy. To check the actual RAW image, use
— the bundled software Digital Photo Professional. ke (53
_ When you have selected a movie, the first frame shot is e
Double-click displayed in the center. For playing movies, refer to p.15.
To set [Reject] for ratings, select the [Edit] menu P> [Change @ @
Rating] P> [Reject], or right-click with the mouse on an image in
the thumbnail window and then select [Change Rating] P @

[Reject] from the menu that appears.
26
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Org aanlng Imag es Introduction

This section explains functions that are useful for organizing images
such as creating new folders for saving sorted images, moving and Table of
You can double-click the folder icon to display the images in the folder in copying images and deleting unwanted images. Contents
the thumbnail image display area.

? When a folder icon appears in the thumbnail image display area

|§| For a list of Preview Mode functions, refer to p.90. Creating a Folder for Saving Images Basic

Operation

You can create a folder to save sorted images.

In the folder area, select the location where the new Ad\gced
folder is to be created. Opglion
Lazt Acquired Images @
High-Level
Functions
Images acquired from your
camera can be accessed here.
Preferences
— Using the
| Faverite Folders | Al Folders | Internet
[ L—?‘-‘ Desktop '
i @ CANON
: M Computer Reference
} Search Results
Contents
Lookup
Index
Add to Favorites
i— e : :

©



Select the [File] menu P> [New Folder].

( )

The [New Folder] dialog box appears.
Enter a folder name and click the [OK] button.

The new folder is created in the folder selected in step 1.

Moving Images

)

Introduction

. . Table of
You can move or copy images to separate folders and organize them Contents
according to shot date or theme.
Drag the image to be moved or copied. Basic
Operation

To move:Drag the image and release when the image is in the
destination folder.

To copy: Drag the image while holding down the < Ctrl > key and
release when the image is in the destination folder.

fity @ | | Viewbruge - | Propenies :] Sisde Shorw | b Seaich [ Delere % Rote

5 fanitenl 4 [0 M2 | St b | v o

!U View & Clsiy Qlfcars GO 0IH-0-E (| Y T
Lia _
':g, Expe R

_

5 Pritsho
G -
1™, Conon MAGE GATEAT | ’ ’

Lt Acquied Insges [+]

e L
e

Celectad Rem:

The image is moved or copied to the folder it was dragged to.

ALy
~ -

:@: Moving images to a folder in the folder area

Drag an image in the main window to a folder in the folder area on the
bottom left of the window in the same way as described above to move

or copy the image.
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Moving Images in Folders

You can move or copy folders that contain images, and organize images
in folders.

Drag the folder to be moved or copied.
To move:Drag the folder and release when the folder is in the
destination folder.
To copy: Drag the folder while holding down the < Ctrl > key and
release when the folder is in the destination folder.

4= | Propenics ] Side Show o sewck 1] Delere

B Acques & Cams Satings Foem Mo | S k]
J i iy Ny Picheas CLOIH-0-E4 U

=T

- o

Sl Pkt Shas

ij CANON MADE GATEWKY

RS Sl
Dkl EET

Celected Bom: |

The folder is moved or copied to the folder it was dragged to.

AL/
N

Q= Moving folders in the folder area

Drag a folder in the main window to a folder in the folder area on the
bottom left of the window in the same way as described above to move
or copy a folder.

Changing Image File Names or Folder Names

Select the image whose name you want to change in
the main window, or select the folder whose name
you want to change in the folder area.

Select the [File] menu P [Rename].

=» The [Rename Image] or [Rename Folder] dialog box appears.

2 Enter the file name or folder name of the image and
then click the [OK] button.
The file name or folder name changes to the new name.

|§| You can also change the file names in the [Properties] window

(p.58) or the image display area in Preview Mode (p.90).
You can also change the folder names in the [Properties] window
(p.58).

)

Introduction

Table of
Contents

Basic
Operation

Adv ed
Op ion

High-Level
Functions

Preferences

Using the
Internet

Reference

Contents
Lookup

Index

29



Deleting Images

Please take care as deleted images cannot be recovered.

Select the unwanted image in the main window.

Click [Deletel].

:gl\ﬁewlmage !_.;:J Properties 7.1‘ Slide Show : ¥ Search ":’7 Delete 4.""3: Rotate

Zoom Mode | Scroll Mode ! Preview Mode |

My Pictures Q R R0~ [l—

Click

The [Confirm File Delete] dialog box appears.

Click the [Yes] button.

The image is moved to the [Recycle Bin] and is deleted from ZB.

Right-click [Recycle Bin] on the desktop and select [Empty
Recycle Bin] from the menu that appears to delete the image
from your computer.

Deleting Folders

Deleted folders cannot be recovered. Please take care as all images
inside folders are also deleted.

In the folder area, select the folder you want to
delete.

Select the [File] menu P> [Delete].

=» The [Confirm File Delete] window appears.

~ Click the [Yes] button.

The folder is moved to the [Recycle Bin] and is deleted from ZB.

Right-click [Recycle Bin] on the desktop and select [Empty
Recycle Bin] from the menu that appears to delete the folder
from your computer.
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Introduction
Registering Frequently-Used Folders as Favorite Folders Select the [Favorite Folders] tab sheet.
. . . Table of
You can register shortcuts for frequently-used folders in the [Favorite . . . Contents
Folders] tab sheet in the folder area to make images easier to find. _SEI_eCt the registered folder to display the images
Please note that because the [My Pictures] folder is registered as a inside the folder.
favorite folder by default, the folder icon appears as [ # 1. _ Basic
Lazt Acguired Images @ Operatio n

Select the folder you want to register.

o kol s e
C d dCCESSE v .
Op ion
Images acquired from your -
camera can be accessed here. ng h-Level
Functions
' Favoiite Folders | 4l Folders|
I
-1 My Pictures
l 2 ) 30000 01 Preferences
T— soce_o 02
| Favorts Folders | A1l Folders | - oo 0 03
=M Desktop olh_Jggeioc 04 .
. &R CANON phntn Click Using the

| - Public -% Search Results Internet

; v-1M Computer |
s 3! Search Results
Reference
Contents
| Add.. I Remove | Lookup
il —
—— The images inside the folder appear. Tl

"2 If you have edited or deleted images in folders you have -
Click the [Add to Favorites] button. registered as favorites @ @

The folder icon changes to [ ¥ ] and is registered as a favorite Any changes done to images inside registered folders will be applied to

folder. the original images. Therefore, please be aware that by editing or @‘
deleting images inside registered folders, you are in fact editing or —
deleting the original images. 31
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Deleting Favorite Folders

If you no longer need a folder you have registered in the [Favorite
Folders] tab sheet, you can delete it from this tab sheet.

Please note that as registered folders are shortcuts, the original folder
will not be deleted when you delete the shortcut.

In the [Favorite Folders] tab sheet, select the folder
you want to delete and then click the [Remove]
button.

Lazt Acguired [mages ﬁ%

Images acquired from your
camera can be accessed here.

" Favorite F_an;i Al Foldersg

£ @ My Pictures

Aadd... ﬂ Remove

The folder is deleted.

Editing an Image

If the brightness or color of images is different from what you visualized
when you shot the photo, you can adjust an image using the editing
functions to bring them closer to what you visualized.

This section explains about automatic adjustment of images, adjustment
of brightness, saturation and contrast, trimming images, inserting text
into images, adjustment of sharpness, red-eye correction, and cutting
movies.

JPEG images deteriorate slightly when edited and saved, and the image
before editing cannot be recovered. For this reason, an edited JPEG
image should be saved as a separate image from the original image.
Chapter 3 explains about high-level editing functions other than those
described above.

|§| You can edit RAW images in Digital Photo Professional (hereinafter,
“DPP”). Select the RAW image in the Main Window and click the
buttons [Edit] P> [Digital Photo Professional Process RAW images],
which will start up DPP. For detailed instructions on using DPP, refer
to “Digital Photo Professional Instruction Manual” (PDF electronic
manual).

Automatic Adjustment Using ZB

The brightness and colors, etc. of the image are automatically adjusted.

Select the image you want to edit.

Click the buttons [Edit] P [Edit Image].

Edit Image

| Stitch Photos ‘

‘ Edit Maovie

‘ Edit EDS Yideo snapshot ‘

The [Edit Image] window appears.
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3

Select the buttons [Auto Adjustment] P [Finish].
Edit Image window

(-

ZeamBrowsar Ex detamings
which fool lo use based on the
type of comechon you wanl ko
ke

“Yau can sk adit e phota with
an waomal inege odtc

Shamness.
Tiim
Ingan Tat

Edil with etemal image adior

3 Flatuan b Man Mavu

=» The [Auto Adjustment] window appeatrs.

Click the [Auto Adjust Image] button.
Auto Adjustment window

B Auto Adju

G
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ll Auto Adjust Image

|| Show Original Image

ae o]
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High-Level
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G

Preferences

Saveds.. ] [ Cancel

=»The image is adjusted.

5 Enlarge the window and check the adjustments.

—

Drag right to enlarge

Fits the image to the window size
Moves the enlargement display position
Zooms in/Zooms out

@ In enlarged view, the [Navigator] window appears and you can
check and move the enlargement display position.
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Window in enlarged display
([E5 Auto Adjustmen - E\

Auto Adjust Image ]

Show Oniginal Image:

Sawve bs... ] [ Cancel

Enlargement display position
Drag to move the enlargement display position

To revert to full view, click [ .=, ] on the bottom left of the window.

Click the [Save As] button and save as a separate
image.

The [Save As] window appears.

Specify the save destination and then click the
[Save] button.

The edited image is saved as a separate image from the original
image.

Adjusting Brightness, Color and Contrast

You can adjust the brightness, color (saturation) and contrast of images.

Select the image you want to edit and display the
[Edit Image] window (p.33).

Select [Color/Brightness Adjustment] and then click
the [Finish] button.
The [Color/Brightness Adjustment] window appears.

Adjust the image.
Drag to the left or right to adjust
Color/Brightness Adjustment window

[ Color  Adjus

Please select adjustment pption:

Calor &djustment - I

Brightness:
Saturation:

Contrast: -

E=] [ =

Undo Al Undo Redo

I Save bs ” Cancel I

Move the slider to the right to make the [Brightness] of an image
appear brighter, the [Saturation] to appear more vivid and the
[Contrast] stronger. Move the slider to the left to make the image
appear darker, and the saturation and the contrast weaker.

The image is adjusted.

)
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Englgrge the window and check the adjustments Trimming an Image

(p-33). You can trim only the part of an image you need, or change the
Click the [Save As] button and save as a separate composition of an image where an image shot horizontally becomes
image (p.34). vertical.

Select the image you want to edit and display the
[Edit Image] window (p.32).

Select [Trim] and then click the [Finish] button.
The [Trim Image] window appears.

Drag the trimming range.
Trim Image window

I The image will be timmed to the area shawn inside
the trim box.

1. Maove and resize the tim box in the preview area.

E¥Y  Advanced Dptions

2. Click Trim Image to apply the settings.

Trim Image

Unda Redo

3. Click Save Ag to cloge this panel

Save As.. Cancel

Zoom Ratio: 13% #: 388, 250, Width: 3110, Height: 2073

Drag

The trimming range can be moved by dragging.
You can change the trimming range by dragging the four corners
and the four sides of the trimming range.

)
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Click the [Trim Image] button.

Inserting Text into Images

)

Introduction

The image is trimmed.

Click the [Save As] button and save as a separate

image (p.34).

. , , , Table of
You can insert the date and time you shot an image and text into an C;’;‘ntgn"ts
image as text.
Select the image you want to edit and display the Basic
Operation

[Edit Image] window (p.32).

Select [Insert Text] and then click the [Finish] button.

The [Insert Text] window appears.

Drag the range for inserting text.
Insert Text window

Insert Text:

Fant Size: 48 -

Text Color. [ ]

Text Attibute: B F U
[¥] &rtialias

Tent:

{ Impart Comment |

[ Import Shooting D ate/ Time |

Unda &l Unda Fedo

*‘g 2 ‘:E': Dﬂ;’

Save bs... l [ Cancel

Adv ed
Op ion

High-Level
Functions

Preferences

Using the
Internet

Reference

Contents
Lookup

Drag

The text insertion range can be moved by dragging.
You can change the text insertion range by dragging the four
corners and the four sides of the text insertion range.

Index
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Using the keyboard, enter the text you want to insert.
r [] &sntialias

Texut:

(F ™

Import Commett

l Import Shoating Dated Time |

The text you enter appears in the window.

Click the [Save As] button and save as a separate
image (p.34).

Adjusting Sharpness

You can make the overall atmosphere of an image harder or softer.

Select the image you want to edit and display the
[Edit Image] window (p.32).

Select [Sharpness] and then click the [Finish] button.

The [Sharpness] window appears.

Adjust the image.

Drag right to adjust
Sharpness window

[ Sharpness - E:AlUsers\CANO!

Sharpen | Uiisharp Mask

0

Unda Al Undo Feda

H Cancel ]

)
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Move the slider to the right to make an image harder and to the
left to make an image softer.
The image is adjusted.
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Englgrge the window and check the adjustments Correcting Red-Eye Automatically
(P-33). You can automatically detect and correct red-eye that occurs when you ggﬁ’t'gn"tfs
Click the [Save As] button and save as a separate photograph people using a flash.
image (p.34). : : :
Select the image you want to edit and display the Basic

Operation

[Edit Image] window (p.32).

Select [Red Eye Correction] and then click the
.. Advaficed
[Finish] button. Ochion

The [Red Eye Correction] window appeatrs.

Click the [Start] button.

High-Level
Red Eye Correction window Functions

Preferences

Using the
Internet

Reference

Undo &)1 Unda Redo

[ Show Driginal Image Co n tents
Lookup

5 = A |
Bl ] Q@ |

Save As ‘ ‘ Cancel

_ - Index
The image is corrected.

Click the [Save As] button and save as a separate

image (p.34). @@
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Correcting Red-Eye Manually

You can manually correct red-eye that cannot be corrected automatically.

Display the [Red Eye Correction] window (p.38).

Enlarge the image (p.33) and then select [Manual
Mode].

Fied Eye Correction:

) At Mode

Start

@ Marual Mode
weak U Strong
2 g
Suround a red area to specify the area you want
to correct
Urile &1 Unds | Reddl |
k [ Show Original Image

BE)a 2 98 | —-

l Save ds... ” Cancel l

Check that [ 3] is selected in step 2 and set the
amount of correction.

@ Marual Mode

i Drag to the left or right to adjust
2

Drag and place a box around the place in the image

)

Introduction

you want to correct and then click [OK]. Table of
— Contents
Red Eye Comection:
) Auto Mode BaS|C
ol Operation
@ Manual Mode
weak Q Stiong
e
lSt.lrroundta red area ta specify the area pou want
High-Level
Undo &l Undao Redo FunCtlonS
I J [ Show Original Image
| ‘ Preferences
Bl&a s
I Savehs... H Cancel
. Using the
Click [OK] Internet

Drag the place to correct

The image is corrected. Reference
Correct other places in the same way.

. . Contents
Click the [OK] button and save as a separate image Lookup
(p.34).
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Editing Movies
You can edit the movies you have downloaded to your computer in a

number of ways, including joining movies together and adding special
effects such as titles and background music.

® Once you have edited movies using these functions, you cannot
play them back on the camera.

1 Select the movie.

¥ Vou [ooh jmemer fiwp

) b L Canmy Someg
T vemsimsr

4,{ i

o Lot

e

P

2 Cli_ck the buttons [Edit] P [Edit Movie].
| zf Edit

‘ Edit Image

Stitch Photos

Edit Maovie

‘ Edit EDS Yideo snapshot

Digital Photo Professional
Process R Images

Click the button on the left to select an editing task,
and then edit the movie.

Select the editing task Shows detailed instructions

i thin WiRR, iU Ean aeasg e this
mn--ﬂeuhmg:au
aleyed bnck.

e i

G
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Introduction
© Storyboard area functions @ [Apply Effect] window functions N
Play movies Convert the selected movie to Table of
Rearrange the order of the selected movies sepia tone or monochrome Contents
Show information for the selected movie Add text to the selected movie Enlarge part Of the
. . . selected movie _
Movie editing function preferences Basic
Remove the selected movie from the storyboard area R
. -m

Total Time: 01:22

Iruage Effects
Use mage as in.

s & Apcl sttects to mage.
] Torsettha Taod abact, Fller abiact, o 16 blyidy & iacion, sabact tha inlhgs and clck ha
a apgicpate bt

Tood Dot J Fites Eisct 11 Magniy Secion

Ywhen you vard to et the image's Transiion sifect, select e [Traniition [ifect] bos and
hek e [Trarton £ ect] button

Tt High-Level
Functions
Transition box (icon for the special effect used in the transition _
between joined movies) o
rererences
© [Arrange] window functions
Rearrange the order of the selected movies Set the effect used in the transition between movies (transition box)* )
Using the
o ) ) Internet
*Select the transition box in the storyboard area and then click the
[Transition Effect] button to set the effect used.
Reference
S Contents
Sl b Lookup
S
Set the playback range for the movie Index
(playback start and end)*
Set rotation or mirroring for the selected movie
*When a still image is selected in the storyboard area, you can |§| When you add to the storyboard area an image with recorded audio @ @

automatically attached. Add the audio file in the [Set Audio] window

select the display period for the still image. that has been shot with a EOS-1D series camera, the audio is not @
on the next page.
41



© [Set Audio] window functions Specify the required settings (save destination, etc.)
Add an audio file to the selected movie* and then click the [Save] button.

e B Automatically sets the optimal size _ _
= — I and frame rate for saved movies Select the folder in which
| — ' the movie will be saved

Set the format of
the saved movie

Use mage's sudor does 34 s

Enter the file name

@ Set auc
| ot cick e ol bton

U
ik sannge cick he [
bution o procesd 1 the ned
p

Save image npetht MotionPLO]
Image Sioe 320 » 240 [araded]
Fravtas Flte 15 Finad/vacisnd [51andud]
Auder 16 bd. Z1050 kM2 Moraneal [S1andand]
Total Tive: 0123

Adjust the audio volume for the selected movie and set
“Fade-in" (gradually increasing volume) and “Fade-out”
(gradually decreasing volume)

Clck [$ arve] buton i save the s sesul

*You can add an MP3 or WAV audio file as background music
(BGM) or as an effects tone. When you add audio to a movie in this

window, a bar showing the duration of the audio file appears under i . or )
g PP [Audio] settings by clicking the [Advanced Settings] button. The

the movie’s thumbnail in the storyboard area. _ _ _ o0
) [Audio] sampling frequency for edited MOV movies is fixed at 48
4 Click the [Save] button on the left. KHZ.

* Frame Rate: number of frames recorded per second
=» The edited movie is saved.

6 Click the [Exit] button on the left.

® When an image type is selected in the [Specify a save image
type] list box, you can specify the [Image Size], [Frame rate]* and

1. AddImages

Arange

Apply Effect 1. Addlimages

5 e_t__:A__lJ_n:liu Arrange

Apply Effect

Set Audio

=» The [Save] window appears.

Save

G
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Introduction

@ If you convert the frame rate of a movie after editing, some scenes Cutti ng Movies

may not playback smoothly. _ ) Table of
/ _— y You can cut any favorite scene from a movie you have shot. are s

Contents
|§| When [MOV (H.264)] is selected in the [Specify a save image D:i:l_ble-C“Ck the movie you want to__ play' Basic
type] list box in the window in step 5, the movie durations that can ERET T e Operation
be saved are as shown below. e | P iy oia-e-ms
phe ] ——
Movie durations that can be saved - L Epaae
Image size —_— B s IS : L
s o SToMS | . 50fps/59.941ps* —mg=  wAEEZ
peresalibs | cues IBns
1920 x 1080 Under 10 min. -~ e s High-Level
. . o ' Functions
1280 x 720 Under 20 min. Under 10 min. _
Double-click
640 x 480 Under 30 min. Under 20 min.
320 x 240 Under 60 min, - PIEEIIeCS
If you attempt to save a movie that is longer than the times shown =» The viewer window appears and the movie plays.
above, a message appears. When this happens, shorten the Using the

TS 6 AL G (15 Teee SiE )] Cick the [Cut Movie] button. Internet

* The frame rates 23.976 fps, 29.97 fps and 59.94 fps are e
respectively displayed as 24 fps, 30 fps and 60 fps in the
camera menu.

Reference

Saving movies may take some time. Saving movies takes a
particularly long time when [MOV (H.264)] is selected in the
[Specify a save image type] list box. Contents
E.g.) Saving a 1-minute movie with an image size of 1920 x 1080 Lookup

takes about 10 minutes depending on the system

requirements (p.87).

Time taken to save varies largely with factors including Index

computer performance and image size, and may take an
even longer time.

Check the message in the dialog box that appears and click the @ @
[OK] button. The [Cut Movie] window appears.
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Click the [ P ] button. Click the [Save] button.
I 00:16/00:18 I Table of
Contents
Basic
Operation

The [Save As] window appears.

Spemfy the file name and save destination and then High-Level
click the [Save] button. Functions
Save in ms N ‘ G ? » ' )
0 s o Rems i Shynseareh: Preferences
e
— Recent Places
! O
Desktop .
. . o Using the

The movie begins to play. =il Internet
Libraries

Click the [ @ ] button at the position you want to set A -
as the start point, click the [ p ] button again to play e

. . .. Q.; Reference
the movie, and click the [ B ] button at the position o
you want to set as the end point. RN == . —_—

The movie is cut. ol Emie
The cut movie is saved as a separate movie from the original Lookup
movie.
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Using the Video Snapshot Aloum Window

You can both play and edit Video Snapshot Albums that were shot on an
EOS DIGITAL camera and downloaded to your computer. Edition
functions include changing the order or deleting Video Snapshots and
adding background music to Video Snapshot Albums.

This function cannot be used to edit movies other than Video Snapshot
Albums.

Playing Video Snapshot Albums
Select an image (Video Snapshot Album) in the main

window.
Images with [ (2]} ] on the thumbnail are EOS Video Snapshot
albums.

Click the buttons [Edit] P [Edit EOS Video snapshot].

£ e

Edit Image

Stitch Photos

Edit Movie

Edit EDS Yideo snapzhot l

Digital Photo Professional
Process R Images

The Video Snapshot Album window appears.

Click the [ =] button.
Opens another Video Snapshot

Displays detailed instructions

Displays Video Snapshot selected in
Thumbnail area

Thumbnail area

A Video Snapshot Album plays.

Displays
Video
Snapshot
information

Adjusts
playback
volume
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Editing Video Snapshot Albums

Changing the Order of Video Snapshots

Select a Video Snapshot in the Thumbnail area.

| Original movie sound

Click the [ [«=]] or [ [=%]] button.
Clicking the [E|] button switches order with the left Video
Snapshot, clicking the [E|] button switches with the right
Video Snapshot.

(= =) x

You can delete a Video Snapshot by selecting a Video Snapshot
and clicking the [ ] button.

You can undo an edit by clicking the [ ) ] button on the top left of
the window, and redo it by clicking the [((}] button.

Adding Background Music to Video Snapshot
Albums

Select [Choose music file] in the |
Thumbnail area.

I Crginal movie sound v] I

Ori und

] list box in the

You can also display the [Open music file] dialog box by clicking
the [J'j ] button on the top left of the Video Snapshot Album
window.

The [Open music file] dialog box appears.

(When you display the [Open music file] dialog box, the [EOS
Sample Music] files open.)
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Select a music file and click the [Open] button.
Mu3|c is added and the music file information is dlsplayed

Music file
information

When [Original movie sound] is selected in the [ | | ] list box in
step 1, music file information is not displayed.

® Video Snapshot Albums that have been edited other than with this
function cannot be re-edited.

|§| Video Snapshot Albums edited with this function can be played on
EOS REBEL T3i/600D.

Saving Edited Video Snapshot Alboums

Click the [] button on the top left of the window.

ﬁ EOS Video Snapshot Task.
I Fie Edt Hep

The [Save As] window appears.

Specify a save destination, enter a filename, and
click the [Save] button.

Exiting the Video Snapshot Aloum Window
Select the [File] menu P> [Exit].

( )

The Video Snapshot Album window exits.
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Utilizing Your Images

You can view your images as a slide show, send them in an e-mail or
use them as wallpaper or screen savers for your computer.

Viewing Images as a Slide Show

You can display selected images in full screen and switch between them
as a slide show.

1 Select images.

2 Click [Slide Show].

s [__ = ] T 2 =
il | View Image Properties ‘I Slide Show gSearch iﬁ Delete |~ Rotate

Zoom Mode | Scroll Mode I Preview Mode|

My Pictures Q Q | R-o v|[E

=» The [View as a Slide Show] window appears.

Set the slide show style and then click the [Finish]
button.
View as a Slide Show window

Slide Shaw Semings

s thin sk io omedn n shido
whaw hoen m group af phom
withar in tha sama or difemnt
faldem

Thes st in which yiu selei
pheras denernmmes ther

Gquince in T whodir dhow

EEOO0OCMNO |
CEDOQHIR
EREEEMEE
ol | L= )

o B e [ okl 2 T

=» The Slide Show window appears and the slide show begins.
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Slide Show window

File name Rating setting
Selects the image**
Prints the image*?
Switches to the previous image
Pauses the slide show
Switches to the next image
Ends the slide show

*1 The image is selected. When the slide show ends and returns to
the main window, the image is displayed as being selected.

*2 The image is selected for printing. When the slide show ends and
returns to the main window, the print dialog box is displayed.

When all the images have been displayed, the Slide Show
window closes and returns to the main window.
To end the slide show half-way through, click [0 ].

Sending an Image by E-Mail

You can attach a selected image to an e-mail and send it.

The attached image to be sent is a copy of the original image and
therefore the original image remains unaffected on your computer.
Please note that the e-mail software for attaching and sending an image
selected in ZB is MAPI-compatible software. Please consult the
Instruction Manual for your e-mail software for settings related to MAPI.

Select an image.

Click the buttons [Print & Share] P [Email Images].

‘ %} Frint & Share

Fhata Print

‘ Ides Print

E azy-PhotoFrint Ex
’ Fhota Print

Create and Print Album

Frint Usging Other Software

| Email Images |

The [Email Images] WindoW appears.

)
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Select [Using the recommended settings.], and then

click the [Attach to Email] button.
Email Images window

File fdt Yoew Jook [niemet  Heip

Fledycing the inisl amnil siza to
ME ar less mgres that athess can
e your images. Ta reduce the
sibe of e email da one of the
feilowrsy

s this Sk o afiach JPEG
:‘“:"'-"“"' Ll - Click Custom Setirgs Y sewre
- %] Confirm Cunont Sndings o aller the quality ol ineges
¥ou £Rn changs image sire and
quably b reduce the sis ol the
wmail gtachments.

3 Fistum i Man Maru

« Figtum in Siep 1 and raducs your
aedechan of mages. Conaider
sending several maits with fwr
imagos.

Click Confwm Currant Setngs i
chack ha smail Anchmant 378

2

=» The e-mail software starts up and the image is attached to an e-
mail.

© Enter the address and a message and send the e-mail.

Creating Wallpaper from an Image

You can make a selected image wallpaper for your computer.
The bitmap image for the wallpaper (extension “.BMP") is created using

a copy of an image and therefore the original image remains unaffected.

1 Select an image.

2 Click the buttons [Export] P> [Export as a Wallpaper].

| ‘@ Ewport

Export Still Images

Export Movies

__-!gg;:tract frames fram a mavie

Export Shnnhng_li'_i_g;:-ertles

‘Export @z a Screen Saver

I‘ Ewport a2 a Wallpaper

| Backupto CO

=» The [Export as a Wallpaper] window appears.
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Introduction

Specify the layout and the save destination for the i
wallpaper, and then click the [Finish] button. Creating a Screen Saver from an Image Table of
Export as a Wallpaper window You can make a selected image a screen saver for your computer. Contents
= ] The data for the screen saver (extension “.SCR”) is created using a
copy of an image and therefore the original image remains unaffected.

Bie [t fw Took |nismet Help

Basic
o ot b e . Operation
I Pyt aels 1 Select an image.
et B Ot ey
wmmﬂﬁmﬁ:ﬁm ﬁ st sl
—— B’ oo 2 Click the buttons [Export] P> [Export as a Screen
wrechiud tolder and shars i with
yeur ierds smlanT Saver] .
l-ﬁ The walpaper wil be ssad as .
Y e benp® i for walpepers | —
’ Spacity i name and foides S ‘ @ EHPD.“’-.— ng h-Level
‘ ; Functions
NOTE: Whllpapars wil bo seved s bimap tbmp) flos ‘Export Still Images.
‘ Export Movies
) Preferences
‘ Entract frames fram a mavie
| -__l-:_lr:port.__ghonting Properties )
- = Using the
” Expart as & Screen Saver Internet
N —_
-»The image you selected for your wallpaper is applied as | Ewport as 3 Walpaper
wallpaper.
H . . ‘ Backup to CD Reference
=» The image you selected for your wallpaper is saved in the
specified folder. - The [Export as a Screen Saver] window appears.
Contents
Lookup
Index

? To revert to the original wallpaper
1 On the desktop, right-click with the mouse and in the menu that @ @
appears, select [Properties].
2 Select the [Desktop] tab sheet. @
51

2 Select the file to become the wallpaper and then click the [OK] button.



Checkmark [Include images in the screen saver] and
click the [Finish] button.
Export as a Screen Saver window

Ble 6t Yoew Took |ntenet Help

Tha neder mwhich you salect
- " ahotos determines heir
feugor fle size) seguance inthe soeen sover

Wsa thin sask o cerio & acrone
B 7T COMpURL T

¥ou £an vave the lu:: near
%o b epcied lalder whars d
vt e figidds.

3 Fistum i Man Maru

Save o File

(2] Spaciy s nsena mesttalsar [ Semen.
» EfUsers\CANOMDocuments\Canon Lilike\Z8S creenS

mverESceenSover scr

1 St s detauh scronn sevnr

NOTE: Screen savers will be saved a3 Windows screen saver (* ser fles. MNOTE;

Ifyau cannai find your scroen
sanvor file on the Windows
Scrman Smertab, you nesd o
Intall it

i b s bl sl
caninins the streen soves ile.
reght-chick on the e and then
click Instail an e shoreut mena

Selbcted Bame: |
—_

=» The data for the screen saver is saved in the specified folder.

Specify the saved screen saver on your computer.

© On the desktop, right-click with the mouse and in the menu that
appears, select [Personalize]. Click [Screen Saver] in the dialog
box that appears to display the [Screen Saver] tab sheet.

© Depending on your OS, right-click with the mouse on the desktop
and select [Properties]. In the [Display Properties] dialog box that
appears, display the [Screen Saver] tab sheet.

Screen Saver

Screen saver

’:_Zl_x_;creensavel vm Settings... ]’ Preview

Wait: 10 .: minutes [] On resume, display logon screen

Power miginagement

Conserve energy or maximize performance by adjusting display
brightnets and other power settings.

Change power settings

Applies the selected screen saver data
Select the saved screen saver data

=@< About the [Include images in the screen saver] checkbox

When you checkmark [Include images in the screen saver] in step 3, the
original image is copied to create the data for the screen saver. This
means that even if the original image is deleted or the file name is
changed, it does not affect the screen saver. However, if you remove the
check mark, the data is created using the original image, and if the
original image is deleted or the file name is changed, the screen saver
will not work properly.
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Writing Images to a CD

You can write selected images to a CD.
This function is only compatible with computers equipped with a CD-R/RW
drive as standard.

1 Insert a CD-R/RW disk in the CD-R/RW drive.
© When the dialog box below appears, click the [ |gse&ss] ] button to
close the dialog box.

& DVD RW Drive (D)
-

[] Always do this for blank CDs:

Blank CD options

E O Burn an audio CD
using Windows Media Player

« Burn files to disc
% using Windows Explorer

View maore AutoPlay options in Control Panel

2 Select the images you want to write to the CD.

3 Click the buttons [Export] P [Backup to CD].
| [ﬁ] Export

E xport Still Images

Export Movies

Extract frames from a movie

Export Shoating Properties

Export az & Screen Saver

Export az a'Wallpaper

Backup to CD

=» The [Backup to CD] window appears.

Specify the settings for writing to the CD-R/RW disk
and then click the [Finish] button.
Backup to CD window

File fdt Yoew Jook [niemet  Heip

Backup Sefings Tha epand ot which your

campuiaremied (bums) dole o
; Salact CO-A Oria o B the £ offects S CD qualy
CD Tite In goneral. slower reconsng
3 spoads crassa OO thet are lnas
Spewd Fautest = Prone 13 g
s thin Sk fo siom copion of
wour phalos o m CEHar ¥ty after bockug.
EnisbABHNG Ohs b oR Ao
complale. T langer, bt wil - Itis nbwerys o good deata
Hicugecc el succssh chamse orlyaherbackus s
( which featis & can wiite e Sl E: L.
et {Borr) €D supcrasshl
Spaca on CO

| S AmmwManben

Uad 0.00 B, Cureant Sasion 695 MB. Remening 695 87 ME

) The He sires abicws ars estimabes only. Thi C0 burmng process.
may ned be completed d the remaming spoce i low.

=»Writing to the CD-R/RW begins.
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Printing Multiple Images on One Sheet of Paper (Index Printing)

3 Specify settings such as the paper type and the
number of prints, and then click the [Print] button.

You can arrange multiple images in index format and print them on one
sheet of paper.

1 Select the images.

2 Click the buttons [Print & Share] P [Index Print].
‘ﬁj Frint & Share

‘ Phota Print

[I Index Print

E azy-PhataFrint Ex
Phato Print

‘ Create and Frint Alburm

‘ Print U zing Other Saftware

‘ Email Images

=»The [Index Print] window appears.

Print preview

G

Introduction

Table of
Contents

Page Layout Setings

Columns: 1 H

Rows: 1 B

Shooting Information

Header/Footer

[ Sefings.

Selected ltems: 16
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Operation

High-Level
Functions

-

G
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)
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=» Printing begins.

ﬁl For a list of index print window functions, refer to p.95.
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3 High-Level Functions

C
a. k

i

Comparing Multiple Images.........c..cccevvvviivievveennnnnn. 56
Listing Images by Folder Level.............ceiiieins 57
Viewing Shooting Information for an Image............. 58
Changing the Size and Type of an Image and
SAVING w ettt 59
Exporting Shooting Information ...................c....... 60
EXPOrting MOVIES .....cccviiiiiiiieceee e 61
Extracting Still Images from a Movie ....................... 63
Organizing Images Using High-Level Functions..... 65
Setting Keywords in Images.........ccouveeiiiieeeieeeiiinnnnnnn. 65
Entering Comments into IMages ............cceeevveeeeeeeennnns 65
Saving Multiple Images with New File Names............ 66
Classifying Images by Shot Date............ccccccoviiviiennenn, 67
Searching for Images .......ccoooveeiviiivii e, 68
Performing Advanced Editing ............cccccooveevnen. 69
Adjusting the Color of an Image in RGB.................... 69
Adjusting the Brightness Level ...........cccoveviiiiiiinneennn. 70
Adjusting the Tone CUurve........cccccceeeeeeeeveveeiiieee e 70
Unsharpening an Image ..., 71
Transferring Images to Other Image Editing Software... 72
Merging Images to Create Panorama Images............ 72
Adding Sound to Images/Playing Back.................. 74
Adding Sound t0 IMageS .......ccooveiiiiiiei e 74
Playing Back Sound ............ccccceeeeiieeiieeeicee e, 74
Printing Using Other Printing Software .................. 75
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Comparing Multiple Images

To compare multiple images, you can split the viewer window into two,
three or four and display multiple images at the same time.

You can also align the display position of enlarged images and compare.

1 In the main window, select the images you want to
compare (p.11).

) Click [ [aalviewinagd] (p.83).

=» The viewer window appears.

3 Select the number of images you want to display at
the same time.

b | MG01010PG 1/ 4)

=» The viewer window is split and the multiple images are displayed
at the same time.

v

[ R |z al woe O 5 M M [E] 5 smowonee
o B [t & | w Uy owr o our [ MGEMRGACG DD ] [ & | b our e Ly | MGSNZRGR/Y

r | MBI PG 4y

[ Zoom Raic: 11%

4 Click [Synchronize] and then enlarge the image.

stz |aE| Show: I:l E D]‘D_:g [@ Synchronize CI|Ck

b | MG.01010PG L/ 4) |,,‘E|; 1{[@-‘ | 9% v

Drag right to change the display magnification

W= s see O 3 M T[] [
S e urpesneca sy B e B [ b our e

| Zoom Raic: 375

=» The synchronize display appears and all the images are
displayed at the same display magnification and in the same
position.

=» The [Navigator] window that displays the enlargement display
position appears and you can check and move the enlargement
display position (p.23).

@ Click [Synchronize] again to cancel the synchronize display. You
can now change the display magnification and move the
enlargement display position for each image.

® To return to full view, click [:EI:] on the top left of each window.

® To cancel the split display, click [[_] ] at the top of the window.
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Listing Images by Folder Level

You can switch the main window display to Scroll Mode that displays in folder

levels and simultaneously view multiple folders and images inside the folders.

You can also set the level to which images and folders are displayed in the
window, which makes looking for the folders and images you want easier.

1 Click the [Scroll Mode] tab sheet.

— - - ;=
| View Image Properties ‘I Slide Show g Search ?ﬁ Delete |~ Rotate
Zoom MUdEl Sorol Mode Iw:‘rewew Made|

tdy Pictures Q

=» The display in the main window switches to Scroll Mode.

2 Select the [Tools] menu P [Preferences].
-» The [Preferences] window appears.

3 Change the depth of the folder level to be displayed.

5 Preferences =

Q| R-0-|X

General |Salection I Rotation I Frirting I Shooting Information I Theme5|

Thumbnail:
Minimum visible thumbnail size: | =

Minimum clickable thumbnail size:

Zooming:
Smooth

Color Managemenit:

[ Adjust color of images using monitor profile

Maximum scrol mode folder depth: [1} = IeveIS]

Wam me when hiding files using the Filter Tool

Introduction
Click the [OK] button.
=» The main window is displayed at the folder depth you set. Table of
) , Contents
Example of display when you have set the folder level setting [3]
E': ‘Aoquirs & Camera Settings . il C:'JMESMW ‘;{ - BaSIC
Em — z::nmmmme Seroll Mode | Preview Mode| SR D-_ o Oper a.tlon
ﬁ Edit » oo
I@ Export )
= rrie Advanced
4‘; CANDN MAGE GATEWAY. Operat|on
F: vpm:u\deyg Auam
- Desktop ———
ijgN
Preferences
Using the
[— e — Internet
Click Number of images inside the folder
and number of folders Reference
=» Folders up to the third level and images inside the folders are
displayed in the window. Contents
© Folders at or higher than the fourth level are displayed as folder Lookup
icons. Double-click these folders to display images and folders
inside the folders.
Index

|§| For a list of Scroll Mode window functions, refer to p.89.

QO
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Viewing Shooting Information for an Image introduction

Enable Zoom Mode (p.88) or Scroll Mode (p.89). |§| In Preview Mode, the same information as the [Properties] window
is displayed on the information display area (p.90). Table of
Select the image for which you want to view the Contents
information.
. . Basic
Click [Properties]. Operaltion
EV\ewlmage :;".\J Slide Show |r Search “_'7 Delete @Rntate gg\é?gt?(?g

Zoom Mode | Scroll Mode | Preview Mode|

by Pictures Q Q | Eﬁ -9 '|E

The [Properties] window (image information window) appears.

v Preferences

Properties window

= — " .
uUsin g the
Madiied: XPOPOO
* File Size KHMB |nternet
W | mace Size e
Data Type IPG
Sounct
P
Path  E:AUsers\CANONAPicturesties_ne 01
() Fie o Reference
1MG_0001

(2] Rating;

Contents
Lookup
Shooting Information;
em Name Value = | n d ex
File Name IMG_000.JPG iEl
Camera Madel Caneon EOS X0 W
Firmware Fimware Version XX

-
Shooting DatedTime  KAROUOGG 00O

Duaner's Name

Shooting Made Program AE
Tof Shutter Speed ] 1/8
Av{ Apettuie Value ) 5.6
Metering Mode Evaluative Metering
Exposure Compens... 0 J
= @
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Changing the Size and Type of an Image and Saving

You can change the size of an image or convert it to a TIFF image

(extension “.TIFF”) or a bitmap image (extension “.BMP”) and save it.

Because the image is saved as a separate image, the original image
remains unaffected.

1 Select an image.

2 Click the buttons [Export] P [Export Still Images].

E xport Still Images

|

‘ Export Movies

Exstract frames from a movie

Export Shooting Properties

Export az & Screen Saver

Export az a'Wallpaper

Backup to CD

-» The [Export Still Images] window appears.

Specify the image size, type, file name and save
destination, and then click the [Finish] button.

Fle Edt View Tooh Intemer Help

30 5 Yo can reduce the emaunt of
—_ mmany your flis ue by
| Fwmizw T CuxRy e x| rasiting e maqes 1o & smaler
e Y1 ¥ Long tide: site
[ I
= 20 e
se this lask \o creste copies of .
your photos, You can chenge o ihee i
sizn, cuadity, rnd imas tpo of = _—
the mxpornd phatos wihoid || =~ d a0 poels
afincing the originais. e hei
Crange g oo
b High
compessses the image marm, The g
Dginal Fila S RanE Images wan't lnok as sharp but the
Wi Fill Size 0KE | Colculone | e siws wil be smalier,
File Nema Setings
abc Add & prafe IMG_
Swa w0 Foider
2| @ Cument Foldar
My Fictunes
W, © SpacsFod | Bows |
EsamiCANONPizures

=» The image is saved as an image separate from the original
image.
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Exporting Shooting Information

You can export as a text file the shooting information recorded to the
image.

1 Select an image.

2 Click the buttons [Export] P> [Export Shooting
Properties].

| ‘[ﬁ] Export

E xport Still Images

Export Movies

Extract frames from a movie

Export Shooting Properties

Export az a Screen Saver

Export az a'\Wallpaper

Backup to CD

=» The [Export Shooting Properties] window appears.

Specify the export shooting information and save
destination, and then click the [Finish] button.

File View Tooh fntemet  Help

Shaoting propartie: s stored
inmages as EXIF information

=] EXIF stands for Exchangashle
| Images Fils Format and i used
i Ery st camers manulactuners.

Lge this tesk i creste & copy of
the phote's shootng properios
o it (%1 fle

Seve ta File
Specily file neme and folder |  Sewees. |

7 | EfUsers\CANONFicures\ZEShootngFiopenes td

NOTE Fropamiss Wit ba smsed ns ted 1) flas.

FEdar without thacAng propases will net ba spansd

=» The shooting information is saved as a text file (extension
“TXT").
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Exporting Movies

You can change the size or type of a movie and then export it as a
separate file.

® Once you have exported movies using this function, you cannot play
them back on the camera.

1 Select the movie.

2 Click the buttons [Export] » [Export Movies].

‘ !;E} Expart |

E xport Still Images

Ewport Movies |]

Exstract frames from a movie

Expart Shooting Properties

Export az a Screen Saver

Export az a'‘wallpaper

Backup h:lED

=» The [Select the save image type] window appears.

Select the image type you want to save and click the
[Next] button.

Vi s g i e ks o e

e (D) =

I1 Letectad Bems 1
L

© Specify the [Rotation settings] as necessary
=» The [Set the save image type] window appears.
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Set the image type you want to save and click the
[Ne

xt] button.

L [ —"——

I e [

©® When [MOV (H.264)] is selected in the [Save image type] list box
in the window in step 3, you can specify the [Image Size], [Frame
Rate] and [Audio] settings. The [Audio] sampling frequency for
edited MOV movies is fixed at 48 kHz. When [AVI (MotionJPEG)]
is selected, you can specify the [Image Size], [Frame Rate],
[Image Quality] and [Audio] settings.

=» The [Specify name of file to be saved] window appears.

Specify the required settings (saved file name, save
destination, etc.) and then click [Finish]

L3¢ Yom rch oty

=» Movie exporting begins.

@ Some time is taken to export movies. For detailed information, refer

to @ on p.43.
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Extracting Still Images from a Movie

You can extract still images from a movie and save them as image files.

Select the movie.

PO T [
Bie (86 ou [ooh jmener fup
e o

T e —
I -
=f

-

ro R W PN ]

r p———

T
A

Click the buttons [Export] P [Extract frames from a
movie].

‘_:_,,“ Export

Ewpont Still Images ‘

Ewport Movies ‘

Extract frames from a movie

Export Shooting Properties

Export az a Screen Saver

Ewport a2 a Wallpaper

Backupto CO

The [Set extraction method] window appears.

Set the extraction method and click the [Next]

TRE——
T e e
s
Py o (11 000 00
e 10
st e
vy e
% Eoacts pomy b v B o w0 0 ool i
Someiy an rtwrval and et e
Sk ek et b
) =
Tomuct o s uae
_" g
—( = @ =
s
2T

® [Extract all frames]
This option extracts all the frames in a movie as still images.

@ [Specify an interval and extract frames]
This option extracts still images from a movie at intervals of a set
number of frames or seconds.
[Specify the number of copies and extract frames]
This option extracts a specified number of still images from the
frames of a movie. The interval at which each of the specified
number of images is extracted is calculated evenly across the
movie’s number of frames.
[Extract a specified image]
This option extracts a still image of a scene of your choice during
movie playback.
The [Preview image] window appears.
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Introduction

Check the extracted images and click the [Next] Specify the required settings (save destination, etc.)
button. and then click the [Finish] button. Table of
© When [Extract a specified image] is selected in the window in T = Contents
step 3, you can play the movie in the upper section of the window
and extract an image by clicking the [Add] button when you reach Basic
a scene you like. Operation
Playback/pause, stop, frame back, Resize the thumbnails
frame forward, volume adjustment, half- T : Advanced
speed playback, double-speed playback e oyt ; = Operation

Tbunan sed fun the procest

_Remove the check mark from the [P——
images before and after the selected

File fdt Yoew Jook [niemet  Heip

Preferences
el e e i Using the
nagets b s b o Internet
e : i, il | i i
= ,ﬁﬁmw i i - v -» Still image extraction begins.

a el v - i T =S Reference
Contents
Lookup
Index
Add/remove all the check marks

Rotate all the images Save the images with check marks @ @

©

64

=» The [Set up save] window appears.



Organizing Images Using High-Level Functions

You can organize images using high-level functions such as setting
keywords and entering comments, renaming multiple files in a single
operation and classifying images by shot year/month/date, all of which
are useful when organizing your images.

Setting Keywords in Images
You can set keywords to identify images. The set keywords are also
useful when searching for images (p.68).

Display the [Properties] window (p.58).

Click the [[3]] button in [Keywords] and then click
the [View/Modify Keywords].
The [View/Modify Keywords] dialog box appears.

Select the keyword(s) and then click the [OK] button.

/55 View/Modity Keywords

Check or uncheck the bozes to change the way Kewwords are applied to the selected files. To add a new Keyword, type the name in the
text field below the desired category, and press the + button.

Peaple: Flaces: Events: Others:
[ Children [l Beach [ Birthday

[ Family [ City [ Holiday

[] Friends I Home [ Party

+ + +

Select the rating to assign to the selected files

I T R RN N Reset

0K Cancel

The keyword is set in the image.

Entering Comments into Images

You can enter information relating to images as comments. The entered
comments are also useful when searching for images (p.68).

Display the [Properties] window (p.58).

Click the [[¥]] button in [Comment].
A field for entering comments is displayed.

Enter text and then press the < Enter > key on the
keyboard.

* File Size: KX MB
e s 5z RO H R
Data Type JFG

Sound: [ ]

View Image, [ ] Protect
Patte  E:SUsers\CANONSPicturesiwss_sx_01

File Mame:
IMG_0001

(&) Rating

Kepwords

Brightress Histogram:

[ aeee—

[#] Shaoting Infarmation:

Item Name: Walue

IMG_0001.JPG

Caron EQS 10
Firmware Wersion 3 %3
ime  CANCGOCOI00R

The entered text is saved in the image.
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Introduction

Saving Multiple Images with New File Names Checkmark [Make copies of files], enter the file name

o _ _ _ and then click the [Finish] button. Table of
You can copy multiple images and save them with new file names in a = .

i Contents
single operation. P s e o s e

. . . Pignams Setings Fienaming your phaios cas 3

Select all the images you want to save with new file - St st s e o Basic

u @ Nrw Name = Number - t
names (p.11). R © St = = peration

gud::iuhnkhmuawwp Shoertng Dt » Mow Mam « Numbr + od
Click the buttons [View & Classify] » [Rename LR -

I i | FI el — Byt ZoanBrowarEX Advanced
Multiple Files]. i S Operation

038 1 rennma tha angnal
ahokos inslead

Examplo of now i name:

‘ m Wiew f Clazzify

| Yiew as a Shide Show

Rename Multiple Files

HEWHNAME 101 300¢

WOITE: Tha ariginal dats type (o) will be retsined

Clazszify into Folder

— Preferences

‘ Search

=» The [Rename Multiple Files] window appears. Using the

Internet

-»Images separate from the original images are saved with the new
names.

Reference

Contents
Lookup

Index

QO

@ In step 3, if you remove the check mark from [Make copies of files]
in the window, please be aware that the file name for all the selected
images including the original images changes.
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Classifying Images by Shot Date

Multiple images can be classified into different folders according to shot
date.

1 Select all the images to be classified (p.11).

2 Click the buttons [View & Classify] B [Classify into
Folder].

‘ m Wiew f Clazzify

Yiew as a Shide Show

Rename Multiple Files

I Clazszify into Folder

Search

=» The [Classify into Folder] window appears.

Specify the folder structure and save destination,
and then click the [Finish] button.

File Ft Vaw Took Intemet Help

Specity Folder Sructure
b Specity toldor shushurs:

\When clnssitang by shoateg
ke, ZoombBrawses EXmll oy
clasidy photas wih shoateg

A ‘YenhionbDee x| dlate infoemetion and skip seer
= - pl g
j . b Examgle Falder Stucture: inforenation
] EAUsorsCANDRFicturos 1
LUisa thin task ko orgesino your ” HDOO{_I_0L
ln:u“mw. Dagnd an By datmuit, ZoamBrowsar £
shoceny eapiss the anpinal phaotss 1o the
i balders. To sove space oo
your compute. chotse i move
the photos instead
Save o Falder
i @ Curent Fokdur
’, My Frckares
! Spocity Foldnr | Browse ]

E\sers\CANDHPictunes

Copy o Mova Imnges

-»Images are classified by shot date.

Settings for Folder Structure

Setting Item
YearMonthDate

Description

Classifies images by creating a first-level folder
according to shot year/month/date.

Year\YearMonthDate Classifies images by creating a second-level folder
for the shot year, and the month and date.

Classifies images by creating a third-level folder
for the shot year, the month, and the date.

Year\Month\
YearMonthDate
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Searching for Images

You can search for images by ratings (p.23), shot date, update,
comments (p.65) and keywords (p.65).

1 Click the buttons [View & Classify] P [Search].

‘ @E Wiew & Clazsify

‘ Yiew as a Slide Show

‘ Rename Multiple Files

Clazszify into Folder

Search

-» The [Search] window appears.

Specify the search criteria and then click the [Next]
button.

& [Maich all canditians Metch amy condiion

@ I Paling
Find images wit: the askeciad rating

A
(&1 ] Moditeatan Dma ’ ‘

Find imagas based on the date they wers Inst modied

& Sheoting Dale
Find images based on the date thiny wens shol

& I Commosnt

Find images inig 0 $olowing words.

(8] 1] Kayaoms
Fincl imagas you has 1ngged with keyweeds

£ vt — -

Celectad Bem:

=» The search begins and the images that match the criteria are displayed.

Introduction
Click the [Finish] button to close the search results P
window. Table of
- The display returns to the main window. Contents
4 Check the searched images in the main window.
© The searched images are displayed as [Search Results] in the Basic
folder area in the main window. If you select this folder, the Operation
searched images are displayed.

Feit Yiew Took [niemet Help Advanced
e O aiverin aalsideshom [ scuen Operation
|‘;UJ“""“-" 7 :::ms.mmlmm e -804 [

s :
.-v Fpe _|| )
. mgmE
“_ MN;(MIMY_. | w ==
.l-f-:(:vmlﬂwﬁ :é IMG_000LIPG  IMG_OMOZIPG  IMG_O0OIIPG  IMG_0004.9G
‘ Sl ‘qi“" =l Preferences
| -jlilll"
"ﬁp._,._,igwm. Al )
B Using the
i Internet
b oo 02 IMG_0009.0PG  IMG_0010.JPG  IMG_D011.0PG IMG_0M2.PG

IMG_OCIZIPG  IMG_ODIAIPG  IMG_ODISIPG  IMGOVIGNG Reference
© The images inside the [Search Results] folder are stored until Contents

you either perform another search or exit ZB. Lookup
@ Any work you do on images inside the [Search Results] folder will

be applied to all the original images. Therefore, please be aware

that if you edit or delete images inside the [Search Results] Index

folders, the original images will be edited or deleted also.

|§| You can click the [| 2 sern ] button in the main window and display

the [Search] window.

©
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Performing Advanced Editing

This section explains image editing using high-level functions based on
the assumption that you are familiar with handling standard image
editing software.

JPEG images deteriorate slightly when edited and saved, and the image
before editing cannot be recovered. For this reason, an edited JPEG
image should be saved as a separate image from the original image.

|§| You can edit RAW images in Digital Photo Professional (hereinafter,
“DPP"). Select the RAW image in the Main Window and click the
buttons [Edit] » [Digital Photo Professional Process RAW images],
which will start up DPP. For detailed instructions on using DPP, refer
to “Digital Photo Professional Instruction Manual” (PDF electronic
manual).

Adjusting the Color of an Image in RGB

You can adjust the color of an image in RGB (red, green, blue).

Select an image and display the [Edit Image] window
(p.32).

Select [Color/Brightness Adjustment] and then click

the [Finish] button.
The [Color/Brightness Adjustment] window appears.

Pleaze zelect adjuztment option:
Calor Adjustment -
o
RGE Adjustment
B ET LLLLE e
Tone Curve Adjustment
Saturation: D 0 =
Counbe gl ﬂ ] E

The window switches to the [RGB Adjustment] window.

Adjust the image.

([E] Color/Brightness Adjus

B | W P

Drag to the left or right to adjust

Please select adjustment option:

E=TE =X

T |

RGE Adjustment

Red
Green

Elue:

Unda Al

ElE=lE]

Undo

Save bs..

] | Cancel

=» The image is adjusted.

image (p.34).

I~ Click the [Save As] button and save as a separate
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Introduction
Adjusting the Brightness Level Adjusting the Tone Curve
You can adjust the level of brightness (balance). You can adjust the brightness, contrast and color of a specific area by ggﬁ’t'gn"tfs
changing the tone curve.
Select an image and display the [Edit Image] window
(p.32). Select an image and display the [Edit Image] window Basic
(0.32). Operation
Select [Color/Brightness Adjustment] and then click
the [Finish] button. Select [Color/Brightness Adjustment] and then click ad ;
. vance
The [Color/Brightness Adjustment] window appears. the [Finish] button. Operation
The [Color/Brightness Adjustment] window appears.

From the list box (p.69), select [Level Adjustment].
The window switches to the [Level Adjustment] window.

Adjust the image.

[E3 Colow/Brightness Adjustmen

Please select adjustment option:

l Level Adjustment - J

Auto Levels i
Channet RGE |

1} 1000 255

[ Show Original Image

Undo Al Unda Redo

aveds ] | Cancel

Drag to the left or right to adjust
The image is adjusted.

Click the [Save As] button and save as a separate
image (p.34).

From the list box (p.69), select [Tone Curve

Adjustment].
The window switches to the [Tone Curve Adjustment] window.
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Adjust the image

[& Calor/Brightness Adj

Please select adjustment option:

Tone Curve Adjustment 'J

Chanrel RGE -

Input: Output:

Use Last Afplied Settings

[ Show Driginal Image]

Undo &l Undo Redn

I have s I | Cancel

Clicktoadd a[ H ] (point)
Adjust by dragging [l ]

The image is adjusted.

The horizontal axis shows the input level and the vertical axis
shows the output level.

The maximum number of [ W] is 10.

To delete a [ M ], either press the < Del > key on the keyboard or
double-click on the [l ]

Click the [Save As] button and save as a separate
image (p.34).

Unsharpening an Image

You can set amount, radius and threshold values and adjust sharpness.

Select an image and display the [Edit Image] window
(p.32).

Select [Sharpness] and then click the [Finish] button.

The [Sharpness] window appears.

Select the [Unsharp Mask] tab sheet and adjust.

i
[E3) Sharpness - EAUsers\CANON\Pictu 0001JPG
Sharpel UnsharuMask
Amount D ] : %
Radied [ | 01 2 pikels
Threshald D 0 2 levels
Unda Al Undo Reda
H = A
I Shve As ” Cancel I

Drag right to adjust

The image is adjusted.
Enlarge the window and check the adjustments
(p.33).

Click the [Save As] button and save as a separate
image (p.34).
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Introduction
Transferring Images to Other Image Editing Software Merging Images to Create Panorama Images
You can transfer images to image editing software other than ZB. You can merge up to four JPEG images to create panorama images. CTgr?t'gn"th
For merging images, start up the image-merging software “PhotoStitch”

Select an image and display the [Edit Image] window from ZB and use.
(p.32). Basic

Select multiple images to merge (p.11). Operation
Select [Edit with external image editor].

Click the buttons [Edit] P [Stitch Photos]. Advanced
Click the [Manage List] button and then register the - Operation
image editing software. ‘ L ea ‘

Select the image editing software in the window that appears. Editina Hig);vel
In the [Edit with external image editor] list box, select [ a1 I Funggpons
the registered image editing software.

. .. Edit Maovie
Click the [Finish] button. ‘ Preferences

The software selected in step 4 starts up and the image selected Edit EDS Video snapshot ‘

in Step lis dlSpIayed Digital Photo Profeszional

Process Ral Images ‘ Using the
=» PhotosStitch starts up and the main window appears. i
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Check the arrangement of the images to be merged

and click the [2. Merge] tab sheet.

@ If the arrangement of the images to be merged is not correct,

drag the images to rearrange them.

.-ﬂ.
Edit View Merge Help

Merge Images Shot in Stitch Assist Mode
Click. [2. Merge] to merge these images.
For images shot as a 380-degree panorama, click [Arange].
select [360 Degress] and then click [2. Merge]

STITCHO.JPG STITCHOZ JPG STITCHOZ.UPG STITCHO4.PG

No. of Images: 4

-

1024768 True Color

|58

=» The window switches to the [2. Merge] tab sheet.

4 Click [Start] to merge.

File Edit Miew Merge Help

Merge Images

g o i Click: [Start] to begin merging.

Dizplay Seams  Merge Sethings

STITCHO1.JPG STITCHOZJPG STITCHOZ.JPG STITCHO4.JPG

MNo. of Images: 4 [Panning (Scenery, etc.) [Focal Length : Auto Acquire - Canon PowerShot Pt @

=» The images are merged and displayed.

Click the [3. Save] tab sheet.
=» The display switches to the [3. Save] tab sheet.
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Check the save range and then click [Save].

[ Eile Edit View Merge Help

Save Image
Click [Save] to save the merged image.
To merge a different image, return to [1. Selection and Arangement],
click [Clear] and then [Clear Al

Adding Sound to Images/Playing Back

You can add sound to images and play back sound which you have
added to images with a camera that has a sound record function.

Adding Sound to Images

You can add WAVE sound files to images (extension “.WAV").

\Image Size: 2667x734

Save range
Drag [ @] to change the range

The [Save As] dialog box appears.

Specify the save destination and then click the

[Save] button.
The merged images are saved.

Select the [File] menu P [Exit].
PhotoStitch exits.

@ See also the Help that are displayed when you click[ ] on the
right of the window for information on operating PhotoStitch and
PhotosStitch functions.

Select an image to which you want to add sound.

Select the [Edit] menu P [Add/Remove Sound].
The [Sound] dialog box appears.

Click the [Add] button and select the sound file to be
added to the image.

© Select a WAVE sound file.

=» The display returns to the [Sound] dialog box.

1‘ Click the [OK] button to close the dialog box.
= The [] icon is displayed on images to which sound has been
added.

Playing Back Sound

You can play back sound files that are attached to images.

Select an image to which a[[il] icon is attached.

Select the [Edit] menu P [Play Sound].
The sound is played back.
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Printing Using Other Printing Software

You can start up printing software installed on your computer from within
ZB and print images.

Select an image you want to print.

Click the buttons [Print] P> [Print Using Other
Software].
The [Print Using Other Software] window appears.

Select the printing software and then click the
[Launch] button.
The printing software starts up and the image you selected in
step 1 is displayed.
Make the necessary settings in the printing software
and print.

"2 Printing software does not appear

Printing software that is incompatible with ZB does not appear in the
[Print Using Other Software] window and can therefore not be used to
print.
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Preferences

You can change any of the ZB functions in the preferences window.

Check the settings displayed for each window before making changes.

Select the [Tools] menu P [Preferences].

Select the tab sheet to be set, make changes to the
settings and then click the [OK] button.

General |Selection | Rotation | Printing | Shooting Information | Themes ||

J
Thumbnail:
Minimum visible thumbnail size:

pixels
Minimum clickable thumbnail size: pbide
Zooming:
Smooth

Color Management:

[T Adjust color of images using monitar profile

Maximum scroll mode folder depth: 0

-

[¥] Wam me when hiding files using the Fitter Toal

General Settings

You can make settings such as adjusting the minimum size of thumbnail
images that are displayed in the main window, the speed of Zoom Mode
(p.88), the levels of image and folder display in Scroll Mode (p.89) and
color management.

General | Selection | Ratation | Printing | Shooting Information | Tharnes|

Thumbnail:
Minimum visible thumbnail size: 4
pixels

Mirimum clickable thumbnail size: )
pixels
Zooming:
Smooth

Color Management

Adjust coler of images using monitor profile

Mzdmum scroll mode folder depth: 0

-

[¥] Wam me when hiding files using the Fitter Tool
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Introduction

Selection Settings Rotation Settings I
You can make settings related to image selection. You can make settings related to image rotation. ggmgn%;

Basic
Selection | Ratation | Prirting | Shooting Information | Themesl | General | Selection | Rotation | Prirting | Shooting Information | Thernes| Operation
Selection Type: When rotated JPEG images are downloaded from the camera:
@ i Windows standard selection ! e Advan qed
") Toggle selection Operatlon
JPEG images rotated on the camera store rotation information
with Shooting Information rather than rotating the actual image.
Task Selection:
i this box is checked, the actual image will be rotated when it is [
[7] Mways select images inside a task downloaded to your computer. ng h L.evel
Functions

—
Howewver, far images with Original Decision Data, the actual
image will not be rotated.

Prelﬂi ces
Prompt me after playing movies with rotation information
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Shooting Information Settings
Table of

You can set the information that is displayed when you click [ =& ] Contents
(shooting information display) in the viewer window (p.91).

Printing Settings

If you are printing with the [Photo Print] window (p.17), you can set
whether to trim the image and print with no borders around the paper, or

to print as is without trimming.

Basic
Operation
| General | Selection | Rotation | Printing | Shooting Information
| General | Selection | Rotation | Printing |Shngﬂng Information | Themesl The selected tems will be shown in the Viewer:
. Advanced
Trim Setting for Photo Print Task) [iFi] File Mame Operation
[l Camera Madel
@ Scale and trim image to fit printable ares; (] Shoating Date/Time
Shooting Maode
[ Lighting or Scene High-Level
[JAmbience Functions

Scale (whilst maintaining aspect ratio) urtil the ertire
printable area is filled with your image. Any excess image
will be timmed.

(7 Do not allow timming of the image

[] Effect

[l Fhota Effect Maode

(] To[ Shutter Speed )

[] 2 Aperture Walue )

[l Metering Mode

Exposure Campensation

[l Digital Exposure Compensatian

[ Autoexposure Bracketing
LI I L= N e PO |

[

SelectAl || CearAl || Restore Defavits

-

Prelﬂices

)

Using the
Internet

-

[ Show valuss only

e Reference
Abways show all of the original image. Fort: [.Parial
MNOTE: i this option is selected, the Trim feature in Step 2
of the Photo Print task will be disabled.

Contents
Prirt tasks must be restated before thiz setting will take effect. Looku p
ok || Cancel
Index
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Themes Settings

You can set the background color for the main window.

| General | Selection | Rotation | Printing | Shooting Information | Themes |_

Select a theme below to change the color scheme used in the
Browser Window and Viewer.

Theme:
Medium Gray (default)

Preview:

Showing/Hiding Task Buttons

You can show or hide task buttons displayed on the left of the main
window according to your requirements. Hiding buttons you do not use
makes operating ZB easier.

Select the [Tools] menu P [Customize].
The [Customize] dialog box appears.

Remove the check mark from the buttons you want
to hide.

Click the [OK] button to apply your changes.

Restart ZB for the settings to be applied.
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Uploading a Movie to YouTube

You can upload movies saved in your computer to YouTube.

Select a movie to upload in the main window.

Click the buttons [Print & Share] P [Upload movies
to YouTube].
The [Upload Movies to YouTube] window appears.

Select the movie from [List], enter the title and other
information, and click the [[@]] (Upload) button.
The [YouTube login] window appears.

Enter your YouTube username and password and
click the [Login] button.

Smooth operation is not guaranteed with regard to future
YouTube specifications or specification changes.

Uploadable movies can be up to 10 minutes long and have a file
size of up to 1 GB.

You cannot upload movies that you have edited on your computer
(except Video Snapshot Albums).

An environment enabling Internet access (subscription with a
provider as well as installed browser software, an in-place line
connection, etc.) is required.

Provider connection fees and transmission fees to provider
access points are incurred separately.
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Using CANON IMAGE GATEWAY

CANON iIMAGE GATEWAY is a free Internet online service restricted to
users who have purchased a Canon digital camera (no membership or
annual fee).

To connect to CANON iIMAGE GATEWAY, it is necessary to register as a
member beforehand. Insert the EOS DIGITAL Solution Disk provided
into your computer and perform registration in the CANON iMAGE
GATEWAY member registration window that appears after installing the
software that includes ZB. You can also use the following procedure to
register as a member.

For detailed information on CANON iMAGE GATEWAY, refer to the
CANON iIMAGE GATEWAY Help.

® To use this function, an environment enabling Internet access
(subscription with a provider as well as installed browser software,
an in-place line connection, etc.) is required.

Membership Registration

You can register as a member of CANON iMAGE GATEWAY.
When you have finished registering, you can also change the
connection information or add cameras.

Register as a member.

I'ﬁ' CANOM MAGE GATEWAY
Feaistersédd Product

Top Page

Yiew Onling Photo Album

Upload Images

The settings dialog box relating to membership registration and
connection information appears.

Click the [Register] button.
The browser software starts up and the CANON IMAGE
GATEWAY membership registration page is displayed.
Perform membership registration by following the on-screen
instructions.
When you have finished registering, you can also change the
connection information or add cameras.

Displaying the Top Page of CANON iIMAGE GATEWAY

The CANON iIMAGE GATEWAY top page is displayed with the browser
software.

{Connect to the top page.

oy :
(2] CANON MAGE GATEwWAY

Regizterdddd Product

Top Page

Wiew Online Photo Album

Upload Images

The [Enter Login Details] dialog box appears.

Enter your user name and password and then click
the [OK] button.
When the connection dialog box is displayed and connection is
completed, the browser software starts up and the top page of
CANON iIMAGE GATEWAY is displayed.
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Uploading Images in a CANON iMAGE GATEWAY Album

You can upload images selected in ZB in a CANON iMAGE GATEWAY
Online photo album. You can also show images in a registered album to
specified people.

The images uploaded in an album are copies, so the original images
remain unaffected on your computer.

Select images to be uploaded in an album.

Connect to CANON iIMAGE GATEWAY.

IJ:I CANOM MAGE GATEWaY

Feaistersédd Product

Top Page

Yiew Onling Photo Album

[ Upload Images

The setting dialog box relating to uploading images appears.

Set the size, quality of the image etc. and then click
the [Next] button.

Enter your user name and password and then click
the [Upload] button.
When the connection dialog box is displayed and connection is
completed, the browser software starts up and the CANON
IMAGE GATEWAY album page is displayed.

Create a new album.
Follow the on-screen instructions to register the images you have
selected in step 1 in a new album.

Displaying a Registered CANON IMAGE GATEWAY Album

You can display images that have been uploaded in a CANON iMAGE
GATEWAY Online photo album with the browser software.

Display an album.

i'f':l CANON MAGE GATEWAY

Register/&dd Product

Top Page

View Online Phato Alburn

Upload Images

=» The [Enter Login Details] dialog box appears.

"y Enter your user name and password and then click
the [OK] button.
=»When the connection dialog box is displayed and connection is
completed, the browser software starts up and the CANON
IMAGE GATEWAY album page is displayed.
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image shot with an Adobe RGB setting and the image shot with an
sRGB setting are matched.

Troubleshooting Deleting the Software (Uninstalling) introduction
If ZB is not operating correctly, refer to the items below. Exit any applications before uninstalling the software.
Also refer to the Help from the [Help] menu or click the [?] button at the Log in under an administrator-level privilege when uninstalling the Table of
top of each window and refer to the Help displayed. software. Contents
To prevent computer malfunctions, always restart your computer after
. you have uninstalled the software. Re-installing the software without
Installation could not be completed correctly first restarting your computer is particularly likely to result in computer Basic
s - o - malfunctions. Operation
elect an administrator-level privilege ([Computer administrator],
[Administrator], etc.) as user setting. You cannot install the software if . .
a user setting other than an administrator-level privilege is selected. Select the [ @] button ([Start] button in Windows XP) Advanced
For detailed information on selecting an administrator-level privilege, » [All Programs] P> [Canon Utilities] » Operation
refer to your computer User’s Manual. [ZoomBrowser EX] > [ZoomBrowser EX Uninstall].
Proceed with the uninstallation as directed by the High-Level
ZB does not work on-screen messages. aliet Sl
ZB does not operate correctly on a computer if its system The software is uninstalled.
requirements are not met. Use ZB on a computer with compatible
system requirements (p.87). =i e
Even if your computer has the RAM capacity (memory) described in
the system requirements (p.87), if other applications are running at
the same time as ZB, you may not have sufficient RAM (memory). Using the
Exit any applications other than ZB. e e
Images do not display properly Reference
Images that are not supported by ZB (p.87) do not display. There are
various types of JPEG and TIFF images, so JPEG images other than
Exif 2.2, 2.21 or 2.3 compatible images and TIFF images other than Contents
Exif compatible images may not display properly. Lookup
With initial settings, the color of images that have been shot in Adobe
RGB appear weak. In this case, check the [General] tab sheet in
preferences and checkmark [Adjust color of images using monitor Index
profile] (p.77). Color management is performed and the color of the

-
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System Requirements

Even though the following are recommended system requirements, not
all computer functions can be guaranteed.

Supported Images

Introduction

Windows 7*1
OS Windows Vista*?
Windows XP Professional/Home Edition*3
PC with one of the above OS preinstalled (Upgraded
Computer | machines not supported)
* NET Framework 2.0 or later is required.**
Windows 7
CPU*> Windows Vista 1.3GHz Pentium or higher
Windows XP
Windows 7 (32bit) | Minimum 1GB
Windows 7 (64bit) | Minimum 2GB
RAM*S ; ; —
Windows Vista Minimum 1GB
Windows XP Minimum 512MB
Display Screen resolution: 1024 x 768 pixels or more

Color quality: Medium (16 bit) or more

«1 Compatible with 32-bit/64-bit systems for all versions except Starter

Edition

*2_ Compatible with 32-bit/64-bit systems for all versions except Starter

Edition

*3 Compatible with Service Pack 3
*4 NET Framework is Microsoft software. It is installed together with ZB.

*> Use a Core 2 Duo 2.6GHz or higher CPU and 2GB or more RAM
when working with MOV movies. However, even if there is nothing
wrong with a movie file, it may drop frame and not play smoothly
during playback, depending on your computer specifications.

Image type Extension
JPEG images shot with a Canon digital (-:rgrk])tlgnotfs
JPEG images | camera (Exif 2.2, 2.21 or 2.3- JPG, .JPEG
compatible JPEG images)
RAW images shot with a EOS DIGITAL .CR2 Basic
RAW images*l| camera excluding EOS D6000, EOS TIF Operation
D2000, EOS DCS1, EOS DCS3 .CRW
TIFF images | Exif-compatible TIFF images TIF, . TIFF
- - - Advanced
BMP images | Bitmap images .BMP Operation
PCD images | Photo CD images .PCD
: MOV movies shot with a Canon digital .MOV High-Level
MOV movies s Nera MOV + THM*2 -
: AVI movies shot with a Canon digital %2
AVI movies Y. AVIE+ . THM

*1 For RAW images, the JPEG embedded in the RAW image is =i e
displayed and printed instead of the actual RAW image. In some
cases, displayed and printed images may be grainy.

2 A« THM” file is a (thumbnail) file generated and saved together with Using the
a movie file when shooting movies with some of Canon digital Internet
cameras.

It has the same file name as the movie and includes shooting
information, etc. When you play on the camera a movie file that was
saved together with a “. THM” file, both the movie file and the “. THM” Reference
file are required.
Contents
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List of Main Window Functions

Zoom Mode

Image search (p.68)
Slide show (p.48)

Properties window (p.58)

Viewer window (p.91)

Folder path

Eile Edit View Tools [nternet Help

Shows/hides
the task buttons

Tasks

0

Task buttons

Folder area*

(
‘ | @] fcquite & Camera Settings

| [ﬁ‘lll Wiew & Classify

I £ e

’ ;;Eﬂ' Expont

i Print & Share

|
|
|
l
|

‘ {:‘ CANDN MAGE GATEWAY

Shows/hides the task buttons and folder area

7
Last Acquired Images

Images acquired from your

camera can be accessed here.

Favorite Folders | All Folders

E . Desktop
=B CANON
i3 Contacts
- Downloads
[~ §r Favorites
W Links
-+ 2| My Documents
-~ W My Music
o Mypwcturﬂ
. weo_e 01
- 200030 02
. 000 30 03
a000_soc 04
- @ My Videos

. I

[T Ry

Add to Favorites

“ﬁﬁj Slide Show |~.’§£’ Search

Zoom Mode | Seroll Made | Preview Mode|

Deletes images (p.30)

Rotates an image

Moves the enlargement display position (p.13)

Full view (p.13)

. |

My Fictures

|

-

r
R 011

w03

Selected Itgms: 0

Movie icon
Video Snapshot icon

Protect icon

RAW image icon
Audio recording icon

Number of selected images

* Images in folders and folders selected here are displayed on the image display area.

Bracketing icon

Display magnification (p.13)
Filter display (p.25)

Reduction display (p.13)
Enlargement display (p.13)

Cancels ['*_ ], ['=,]or[
Shows/hides the image or
folder information
Selects/deselects all the
images or folders

Displays the folder one level
above

Returns to the display of the
folder before [ (3} ] is clicked

Returns to the display of the
folder previously displayed

Image display area

]

)
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Scroll Mode Image search (p.68) Deletes images (p.30)
Rotates an image

Slide show (p.48)

Properties window (p.58)

Viewer window (p.91)

I @ - CAMOM iMAGE GATEWeY

Folder path
Shows/hides —— === | t . ——t
the task buttons Tasks (i | Yiew Image -_:_:)J Properties Siideshuw @Sﬁlﬁh j Delete ‘5‘2}\ Rotate
IE Arﬂuue& Camera Settings Zoom ode | Serall Mode | Frovi D.dﬁl
l@ View & Classity ] e 90O RO [ F i
Task buttons EES |
I@ Prinit & Share ]
Last Acquired Images 6

Images acquired from your
camera can be accessed here.

ders | All Folders
i£3

Folder area*

&
G | Photo
3 Search Results

Selected fems: 0

Shows/hides the task buttons and folder area

Number of selected images

* Images in folders and folders selected here are displayed on the image display area.

Display magnification (p.13)
Filter display (p.25)

Shows/hides the image or
folder information

Selects/deselects all the
images or folders

Displays the folder one level
above

Returns to the display of the
folder before [ (3} ] is clicked

Returns to the display of the
folder previously displayed

Image display area

Reference
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Introduction
Preview Mode Image display area Image search (p.68)
: : Table of
Slide show (p.48) Deletes images (p.30) Contents
Viewer window (p.91) Rotates an image
Folder path o v 0 0 [ I N Basic
Shows/hides ET kgdm View Tools [Internet ﬂerg —— - — . 2 . Operat|0n
the task buttons = . . \ B viewimage Properti lv‘n"l SiidefShow | b Search [ Delete '-&_J Rotate
l_i] Acquire & Camera Settings l ZUDmMUdeI SoralModa Preview Mads |
| Tl v oty ‘ s 01 QIR0 Fr Filter display (p.25) Advanced
ilé: Infarmbtion: = N . O eratlon
P ] gl s “1 1 Shows/hides the image or P
= odified SRS ] Protect i i
Task buttons [Ed’ Byt ] Fle Size e . ‘| folder information
(5! pintshae | L . — Selects/deselects all the High-Level
ata Type: E . n
\‘Z‘Q e N ‘L images or folders Functions
< N — Displays the folder one level -
Last Aequired Images @ R AT
Corrment “ above
Kesmwards: | ) Preferences
i s s T g =ri— Returns to the display of the
N ' “ folder before [ (3 ] is clicked
—1+— Returns to the dISplay of the Using the
| | . .
Internet
*1 Favarite Folders | &l Folders (TX3 Shooting Infomation: ) fOIder preVIOUSIy dlsplayed
Folder area — . hemMame  value -
& & CANON i File Name IMG_0006.IPG
- 7 Contacts Camera Maode| Canon EOS Hxx = . .
4 Downloads Firmware Firmuware Wersion .5, T |nf0rmat|0n dlSplay area
B Favorites = Shooting Date/..  KXAKAOOUOGCH || Reference
.. jff Links Owner's Name
4wy ocumens ‘ e e Shooting information (p.58)
& g M: Pi:;:&‘ || < Previous Aol Aperture Vel 56
o Contents
i — Thumbnail image display Lookup
H My Videos X area*Z
d = l : J IMG_0001.JPG  IMG_000Y.JPG  IMG_DO03.0PG  IMG_0004.JPG  IMG_0005.JPE  IMG_000G.JPG  IMG_0007.JPG IMG_0009.0PG  IMG_0010.
Add to Favarites <1 i ]
Selected fems: 1 I n d ex
| .
Switches between images Number of selected images
Shows/hides the task buttons and folder area ) _ ) )
Shows/hides the information display area @ @
1 Images in folders and folders selected here are displayed on the thumbnail image display area.
*2 Images selected here are displayed on the image display area.
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List of Viewer Window Functions

Photo print window (p.94) Edits (p.32 to p.39, p.69 to p.72)
Shows/hides the AF point
Shows/hides the shooting information (p.14, p.22)

Moves the enlargement display position (p.23)
Reduction display (p.23)

Split displays (p.56)

Folder path

Switches between

images

Fit-to-window view
(p.23)

100% (actual pixel
size) view

Display magnification
(p.23)

Full view display (p.14)
Rating (p.23)

Zoom Ratio: 22%

Synchronize (p.56)
File name

)
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List of Cut Movie Window Functions ¢.43 Introduction

Table of
Contents

Basic

Displays the movie Operation

Advanced
Operation

Previous frame Next frame

High-Level
Functions

-

Stops the movie Mutes

G

Plays the movie

Adjusts volume

o . . Preferences
Current position during movie play

)

Sets the start point for a movie cut Sets the end point for a movie cut Using the
Internet
%) J—

Reference

Saves a cut movie as a separate movie
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List of Video Snapshot Album Win

Redoes edit
Undoes edit | Saves Video Snapshot Album

Opens music file Displays detailed description

—
{28 EOS Video Shapshot T -

|| File Edit Help

52 00 £

Opens Video
Snapshot Album

m .»wf*’f—

Video Snapshot
selected in Thumbnail
area

Deletes Video Snapshot —+
from Thumbnail area

Plays Video
Snapshot Album

Changes order of
Video Snapshots

Presently selected Video Snapshot

dow Functions

Original movie information
Fle Name
Path
Fle Size
Image Size
Frame Rate
Recording Time
Sampling Frequency
Sample Size
Shooting Mode

Music Fle information
File Name
Path
Fle Size
Play Time
Sampling Frequency
Sample Size

i

(p.45)

OO O O]
DO
X XX MB

OO MO

K KX Frames/secot
OO R

X KKK kHz

¥ Bit

X sec. movie

FOOO I wav

(6= S bbbt bbbt
K.®XX MB
OO X

K KM kHz

KA Bit

| ANGELS wav

Thumbnail area

Movie information

Music file
information

Adjusts volume
Selects audio
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List of Photo Print Window Functions

Printer selection and —
settings

File Edit View Tools Internet Help

é Fhaoto FPrint
=]

Trims the image

1 Selectimages

Printer and Layout Settings.
= =8

(Printer

MName:

[CanDnXXX 'l

Media Type:

Fhoto Setiings and Preview

Trim Irmage

Remove unwanted regions
of your phota.

Inserts text

Add or Modify text to printwith
this photo

IPIam Faper vl

Papet Size:

[ad

[ 41 Return to Main Menu I \_

Borderless

\

-
Shooting Date/Time

MNohe

I-Drnper.ii-es

Photo: 1/1

< Previous ” Print

I

[ Cancel

]

Copies: 1_é

Total: 1 pages

— Print preview

Selected ftems: 1

Shot date and
time printing

Borderless printing

Number of prints

Switches the printing image
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List of Index Print Window Functions= s | Niroduction
. . . Table of
Printer selection and settings Contents
Basic
Operation
( Frinter ) Preweth . — —— Advan Ced
Mams: | &) =3 ‘ E=3 Operation
[Canon 4 ‘] Fotate Left FRotate Right Trim lrnage
ﬁ?:?;;?:r -] High-Level
t Paper Size: FunCtIOI’]S
errrrr— S d)
. . Orientation: . .
Paper orientation Qe B Landscape} ® Print preview
Preferences
Copies: 1 Eﬁ
Total: 2 pages
'Page Layout Settings s USing the
Layout settings ——| Calurnn: T\ Internet
Rows: 3 E )
Shooting Information \
Print information s Reference
. eader/Footer
Contents
Lookup
|:‘ Fage: 1/2 (_E]'_)
< Previous ” Frint ] [ Cancel |ndeX
Selected ltems: 16 l

Number of prints Switches the printing page @ @
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Introducti
Contents Lookup
Downloading Images to Your Computer Image Editing o of
Table o
Download images by connecting your camera Use automatic adjustment =»p.32 Contents
and computer = p7 : .
. _ Adjust brightness/darkness ->p.34
Download images using a card reader =>p.9 Make colors more vivid - p.34 r
; h Operation
Image Checking Raise the contrast =*p.34
Look through -»pi1 Trim parts of an image = p.35 I
- Specify an aspect ratio that matches the size of Operation
Enlarge anfi view ?p.13,p22 the paper on which an image is to be printed P35
Play a.mowe 2 p.15 Make an image sharp -> p.37 High-L evel
Play Vlde? .Snapshot Albums -» p.45 Insert text - .36 -
Check efficiently - p.26 Correct red-eye - .38
Compare multiple images - p.56
Check the shooting information such as shot °Q" e g
dato 9 - p.58 ® Edit movies - p.40
View as a slide show - p.48 Cut a favorite scene from a movie -> p.43 o
® Extract still images from movies -» p.63 Internet
Image Printing Edit Video Snapshot Albums -» p.46
Print one image on one page = p.17 o met
ererence
Print using Easy-PhotoPrint EX = p.18 Utilizing Images _
Arrange multiple images on one page and print =» p.54 Attach an image to an e-mall = p49
Make into computer wallpaper = p.50 Contents
Organizing Images Make into a computer screen saver - p.51 Lookup
Sort by rating =*p.23 Upload a movie to YouTube - p.82
Move to a different location ->p.28 Using CANON iMAGE GATEWAY =» p.83
Move by entire folder to a different location = p.29 _
Change the file name = p.29 Converting Images @ @
Delete - p.30 Change the sge - p.59
Classify by shot date - p.67 Convert to a different type - p.59 @
Search -» p.68
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A
Adding SoUNd 10 IMAGES.........uuiiiiiieieiiiiiee e 74
Adjust JPEG IMAJES......cciieeiiiiiiei e eeeeeeetiss s e e e ee et e e e e e eeanens 32, 69
Adjusting (JPEG of TIFF IMaJE).....cccuuiiiiiiiiiiiiiiee e 32, 69
AdJUSEING INRGB ... .o e 69
Adjusting the Brightness............coooooiiii s 34
Adjusting the Brightness Level ..........ccccceeiiiiiiiiiieeeiee 70
Adjusting the CoNtrast ..........ccoeeeiiiiiiiiiie e 34
Adjusting the Saturation ...................cc i, 34
Adjusting the Sharpness ......c.cocoovviviiiii e, 37
Adjusting the ToNe CUIVEe........ccovivieiici e 70
Automatic AdjUSIMENt ... 32
COorrecting REU-EYE ......cooiiiiiiiiee e 39
Unsharpening MasK ..........ccccuuiiiiiiieeiiiiieee e 71
Adjusting the Brightness ........cccccoiiiiiiiiiieaennees 34
Adjusting the Brightness Level...............uuueiiiiiiiiiiiiiiiiiieieieeeeeeeeeeeeeeeee 70
Adjusting the CoNtrast...............uuvviiiiiiiiiiiiiiieee e —————— 34
Adjusting the Saturation....................eeeieeiiieiiieieeeeeeeeeee e 34
Adjusting the SharpneSS..........uuuiiiiiiiiiiiii e 37
Adjusting the TONE CUINVE ........uuuiiiiiiiiiiiiiiiiiiiieieeeeieeieeeeeeeeeeeeeeefeeeeeeaes 70
Attach an Image to an E-malil................uuvvuiiiiiiiiiiiiiiiieiiieiieeeeeeeeesieee 49
AUutomMatic AJUSTMENT ... eeeenaee 32
B
Batch Change the File Name of Images..............uuuvveeiiiiiiiiiiiiieiiieeeeee. 66
C
CANON IMAGE GATEWAY ..ottt 83
Displaying an AlDUM ..........ccoooiiiiiii e 84
Membership Registration ...........ccccccvvviiiiiiiiii 83
Uploading Images in an Album ... 84
Change File Name ..., 29
Change Folder Name...........ooooiiiiiii 29
Change the Display Magnification ...........cccccccoeeeeii e, 13
Changing the Folder Level Settings.........cccooooiiiii, 57
Changing the Size and Type of an Image and Saving....................... 59
Checking the Shooting Information..............cc 58
Classifying the Images by Shot Date...........ccccoeeeveeiieiieee, 67

Color Management.......coooiiieoie e 77
Compare Multiple IMages.........oooeeeiiieiiececcce e 56
CONTIAST ... e 34
Correcting REA-BYE ......cooooeii i 39
Creating @ FOIAEN ..o e e 27
CULtING 8 MOVIC....oiiiiiiiiiieiii et 43
D
Delete
Delete FOlders. ... 30
Delete IMAgeS.......cc i e 30
Delete the Software ... 86
Delete FOIEIS ... eeeeeeeeeees 30
Delete IMAGES ..couvieiii i e e 30
Delete the Software (Uninstalling) ............cocovviiiiiiiiiiiiiiiiieeee e 86
Deleting the ZB (UnNINStalling) .............uvivuiiiiiiiiiiiiiiiiiiiineeeereierreeeeee.. 86
Displaying Images Shot with Adobe RGB ...........ccccooiiiiiiiiiieeiiie 86
Downloading an Image to Your COMPULET ...........evvvevireererirereeereeeneenenes. 7
Downloading Images from a Camera ..........ccccuveeeeeeeiiiiiiiiiieeeeeeens 7
Downloading Images from a Card Reader............ccccoviivivieeeeeennns 9
Downloading IMaAgeS .........uuuuuuuuiiiiiiiiiiiiiiiiiiiiiirerreerarrrrrerrererrre ... 7
Downloading Images from a Card Reader .............occcvvvveeeeeeiiiiiinineeen. 9
E
EdItiNg....cooiiiii —Adjusting
EditiNg MOVIES ....ooiiiiiiieeee et 40
ENlarge FOIAErS ... 12
ENlarge IMages .......cvuiiiiiieeeiieiee et 13, 23
EXITING ZB ...ttt e e eees 20
EXPOItiNG MOVIES ... . eeeeeeeeeees 61
Exporting Shooting INfOrmation .................eeeeeiieiiiiiiiiiiieiiieiieeeeeeeeeeeee 60
Extracting Still Images from a MOVIE ............uuvveviiiiiiiiiiiiiieeiiieeeeeeeeeee 63
F
Favorite FOIAers. ... ... 31
FUll VIEW DISPIAY ... 14
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General Settings (PreferenCes) ........uvvvviiiiiiiiiiiiieeceee e 77

I

INAEX Printing ..o 54

INSEIT TEXE ...t e e 36

INSErtiNg COMMENTS .. ... eeeeeeeeeneee 65

INserting TeXt iNtO IMAQJES........uuuvurririiiiiiiiiiiiieireeiierereereeerrrreeeeeereraee—. 36

K

KeYWOrdS SEetliNGS .....cuvviiiiieeiiiiiiiieii e e 65

L

Listing Images by Folder Level ..., 57

M

MaIN WINAOW ...ooiiiiiiiiiiiiiie ettt 7,88

Merging Panorama IMagesS. ..........uuuuuuuuurruueniieiieeieneeaeeeeeeeeeeeeeeeeeeeeeeees 72

Move or COPY FOIAEIS......... e 29

MoVve OF COPY IMAGES.....coeiiiiiiiie et 28

N

NP A2 T F= (o] g1/ o [0 12RO 13, 23

@)

Operating With EOS UTIlILY .....coveeiiiiiiiiiiiiieeee e 8

P

PIaYiNg @ MOVIE. .. ...ttt eeeeeeeeeeeeees 15

Playing Back SOUNG.............uuuuiuuiuuiiiiiiiiiiiniieieiiieeniennersreneresreeerrnen. 74

PrEIEIBNCES. ...ttt e e e e ees 77
General SEtiNGS. ... ..uuuuuiii 77
Printing SEtiNgS ..ovvvviiiei i 79
ROtation SEttNGS .....cvvveiiie e 78
SeleCtion SettiNgS. .. .. . 78
Shooting Information Settings .........coovvviiiiiiiieieee e 79
THEmMES SEtHNGS ...cooeiiieiiiie e 80

Preview Mode (Main WiNndOW) ...........uuveveiieiiieeieiiieeeeeeeeeeeeeeeeeeeeees 26, 90

Printing
INdeX Printing ....cooovvieie . 54
Printing an Image Using Easy-PhotoPrint EX ..........ccccccceeeeeeee, 18

Printing One Image on One Sheet of Paper .................cc.oeee. 17

Printing with Printing Software other than EPP EX...................... 75
Printing an Image Using Easy-PhotoPrint EX ...........cccccovvieiiniiiinnen. 18
Printing One Image on One Sheet of Paper.........ccccccceeeiiiiiiiivieivinnn, 17
Printing Settings (Preferences)...... ..o 79
R
RTINS .o ettt e e eeeeeas 23
Rewriting Images to a Memory Card..............eveevveeeiriveeeeeeeeereeeeeeeeenne. 16
ROtate iIMAgES ... 88, 89, 90
Rotation Settings (PreferenCes) .........uuuvvviiviiiiieeiiiiiiieeeeeeeeeeeeeeeeeeeeeeees 78
S
Scroll Mode (Main WINAOW)........coouviiiiiiieeeeeiiiiieee e 57, 89
Searching for IMages ..., 68
Selection Settings (PreferenCes) ........vviiiiiiiiiiieeiieeeee e 78
SettiNng @ SCrEEN SAVET........cii i e e 51
Setting @ WallPaper ....c....ueeiiiieiiiiie e 50
Setting an Image as a SCreen SavVer.......ccooeeeiieiiieeeieeeccceceeee s 51
Setting an Image as Wallpaper ... 50
Shooting Information Settings (Preferences)........ccoooovveiiiiiiiiiiiiiiicnnns 79
SIMPIE DISPIAY .. .eeeieeeeeete et 11
SHAE SNOW....ceiiiiiiiiee e 48
STArtING UP ZB...ooiiiiieiee e 7
SUPPOrted IMAGES ....cooe oo 87
SYNCronize DiSPIAY ........uvveiiiiiiiiiiiiiee e 56
System ReqUIFEMENES .....coooeiiii e 87
T
Themes Settings (PreferenCes).......c..uvvevvieiiiiiiiiiiiieceeieeeee e 80
Thumbnail Display (Main WindOW) ........cccoeeiuiiiiiiiie i eeeee e 11
Transfer Images to other Image Editing Software ............cccccvveeeeennnne 72
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THMMING &N IMAGE.....co i 35
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UNSharpening MasSK ...........coueiiiiiiiiiiiiiiee e 71

Using the Video Snapshot Album Window ............cccceeeivviieenieieiiinnnnnn. 45
Editing Video Snapshot Albums ... 46
Playing Video Snapshot Albums ...........ccccooi 45
Saving Edited Video Snapshot Albums........ccccoovveeiiiiiiiiicinnneeee, 47

\%

VIEWET WINUOW ...ccvniiii ettt e et e it e e 14, 22, 91

ViIEWING @N IMAQJE ....uuuuiiriiiiiiiiiiitiiiiiietieireaseeereesereebeeressreaerersseesarsrrreeee. 11

W

WIriting IMages 10 @ CD ..ooooviiiiiiieecce e 53

RTAY LT I o = W I 53

Z

Zoom Mode (Main WiNOW) ........ccooeiiiiiiiiiieeee e 11, 88

About This Instruction Manual

It is prohibited to reproduce, in whole or part, the contents of this
Instruction Manual without permission.

Canon may change without notice the software specifications and
contents of this Instruction Manual.

The software screens and displays printed in this Instruction Manual
may differ slightly from the actual software.

The content of this Instruction Manual has been reviewed thoroughly.
However, if you should notice any errors or omissions, please contact
a Canon Service Center.

Please note that irrespective of the above-mentioned, Canon does
not take responsibility for the outcome of the operation of the
software.

Trademark Acknowledgments

O Microsoft and Windows are registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.
Other names and products not mentioned above may be registered
trademarks or trademarks of their respective companies.
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